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Preface

This section describes the purpose and organization of this guide: Getting Started 
with Oracle Management Pack for SAP R/3.  Specifically, it covers the following topics:

■ Purpose of This Guide

■ Intended Audience

■ Documentation Accessibility

■ Structure

■ How to Use This Guide

■ Oracle Enterprise Manager Pack Information

■ Oracle Enterprise Manager Documentation

■ Oracle Support

Purpose of This Guide
The Oracle Management Pack for SAP R/3 consists of the Oracle Performance 
Manager and Oracle Capacity Planner applications. It also includes Oracle Event 
Tests that are provided with the Oracle Management Pack for SAP R/3.

This guide provides an overview of the Oracle Performance Manager and Oracle 
Capacity Planner applications. It also describes the Oracle Event Tests that are 
provided with the Oracle Management Pack for SAP R/3.  As the guide describes 
how to use these applications and the Oracle Event Tests that are provided with the 
Oracle Management Pack for SAP R/3, it also introduces you to key concepts and 
terminology.
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Intended Audience
This guide is written for those who want to use Oracle Performance Manager, 
Oracle Capacity Planner, and the Oracle Event Tests that are provided with the 
Oracle Management Pack for SAP R/3.

This guide assumes that you are familiar with the Oracle Enterprise Manager 
console and base applications.  If you are not, please read the Oracle Enterprise 
Manager Concepts Guide and the Oracle Enterprise Manager Administrator’s Guide.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/.

Structure
This guide is organized as follows:

Chapter 1, "Overview of the Oracle Management Pack for SAP R/3"

Provides an overview of the Oracle Management Pack for SAP R/3.

Chapter 2, "Post-Installation Configuration"

Provides information on how to configure the Oracle Management Pack for SAP 
R/3 after it is installed.

Chapter 3, "Introduction to Oracle Performance Manager"

Provides an overview of the Oracle Performance Manager application and its 
features.

Chapter 4, "Introduction to Oracle Capacity Planner"

Provides an overview of the Oracle Capacity Planner application and its features.

Chapter 5, "Introduction to SAP Event Tests"
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Provides an introduction to the Oracle Event Tests that are provided with the Oracle 
Management Pack for SAP R/3.

How to Use This Guide
This guide should be read in its entirety to provide you with an overview of Oracle 
Performance Manager, Oracle Capacity Planner, and Oracle Event Tests that are 
provided with the Oracle Management Pack for SAP R/3, so that you are familiar 
with the tasks that the applications can perform and with the Oracle Event Tests 
that are provided. The online help provides more information about the 
applications.

Oracle Enterprise Manager Pack Information
The Oracle Enterprise Manager product family includes several packs: Oracle 
Change Management Pack, Oracle Diagnostics Pack, Oracle Management Pack for 
Oracle Applications, Oracle Management Pack for SAP R/3, Oracle Standard 
Management Pack, and Oracle Tuning Pack.  Each pack is fully integrated into the 
Oracle Enterprise Manager Console framework.

Oracle Change Management Pack

■ Includes Baseline Viewer, Change Manager, Compare Database Objects, Create 
Baseline, DB Alter, DB Propagate, DB Quick Change, Find Database Objects, 
and Plan Editor.

■ Tracks metadata changes in databases.

■ Eliminates errors and loss of data when upgrading databases to support new 
applications.

■ Analyzes the impact and complex dependencies associated with application 
change and automatically performs database upgrades.

■ Allows you to find the database objects that match a set of search criteria that 
you specify.

■ Initiates change safely with easy-to-use wizards that teach the systematic steps 
necessary to upgrade.

Oracle Diagnostics Pack

■ Includes Oracle Performance Manager, Oracle Capacity Planner, Oracle Trace, 
Oracle TopSessions, and Oracle Event Tests that are provided with the Oracle 
Diagnostics Pack.
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■ Monitors, diagnoses, and maintains the health of databases, operating systems, 
and applications.  Real-time analysis is used to analyze current problems, and 
historical analysis is used to analyze trends that could cause future problems.

■ Provides powerful capacity planning features that enable users to easily plan 
and track future system resource requirements.

Oracle Management Pack for Oracle Applications

■ Includes Oracle Performance Manager, Oracle Capacity Planner, and Oracle 
Event Tests that are provided with the Oracle Management Pack for Oracle 
Applications.

■ Monitors, diagnoses, and maintains the health of Oracle Applications. Real-time 
analysis is used to analyze current problems, and historical analysis is used to 
analyze trends that could cause future problems.

■ Provides powerful capacity planning features that enable users to easily plan 
and track future system resource requirements.

Oracle Management Pack for SAP R/3

■ Includes Oracle Performance Manager, Oracle Capacity Planner, and Oracle 
Event Tests that are provided with the Oracle Management Pack for SAP R/3.

■ Monitors, diagnoses, and maintains the health of an SAP R/3 system. 

■ Provides powerful capacity planning features that enable users to easily plan 
and track future system resource requirements. Real-time analysis is used to 
analyze current problems, and historical analysis is used to analyze trends that 
could cause future problems.

Oracle Standard Management Pack

■ Includes Baseline Viewer, Change Manager, Compare Database Objects, Create 
Baseline, Oracle Index Tuning Wizard, Oracle Performance Manager, and 
Oracle TopSessions.

■ Monitors and diagnoses problems, tunes high impact indexes, and tracks and 
compares changes in your Oracle environment.

Oracle Tuning Pack

■ Includes Oracle SQL Analyze, Oracle Expert, Oracle Index Tuning Wizard, 
Reorg Wizard, and the Tablespace Map.

■ Optimizes system performance by identifying and tuning major database and 
application bottlenecks such as inefficient SQL, poor data structures, and 
improper use of system resources.
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■ Proactively discovers tuning opportunities and automatically generates the 
analysis and required changes to tune the system.  Inherent in the product are 
powerful teaching tools which train DBAs how to tune as they work.

■ Instills "Consultant Quality" tuning expertise into developers and DBAs and 
increases their productivity.

Oracle Enterprise Manager Documentation
The Getting Started with Oracle Management Pack for SAP R/3 manual (this manual) is 
one of several Oracle Enterprise Manager documents.

Oracle Enterprise Manager base documentation

■ The Oracle Enterprise Manager Readme provides important notes regarding the 
online documentation, updates to the software, and other late-breaking 
information for Oracle Enterprise Manager and the Oracle Management Packs.

■ The Oracle Enterprise Manager Administrator’s Guide explains how to use Oracle 
Enterprise Manager, Oracle’s systems management console, common services, 
and integrated platform tool.

■ The Oracle Enterprise Manager Concepts Guide provides an overview of Oracle 
Enterprise Manager.

■ The Oracle Enterprise Manager Configuration Guide explains how to configure 
Oracle Enterprise Manager.

■ The Oracle Enterprise Manager Messages Manual describes the Oracle Enterprise 
Manager error messages and methods for diagnosing the messages.

Oracle Enterprise Manager and Management Pack Installation documentation

■ The Installation Guide for Oracle Enterprise Manager with Oracle Management Pack 
for SAP R/3 provides information for installing the Oracle Management Pack for 
SAP R/3. The Installation Guide for Oracle Enterprise Manager with Oracle 
Management Pack for SAP R/3 is provided on the Oracle Enterprise Manager 
with Management Pack for SAP R/3 installation CD-ROM or you can get a free 
download of the manual from the Oracle Documentation Center at 
http://docs.oracle.com/.

■ The Oracle 9i Installation Guide Release 9.0.1 provides important information for 
installing the Oracle Enterprise Manager Console and the Oracle Management 
Packs. This manual also contains information such as hardware and software 
requirements, installable components, and deinstallation procedures. The Oracle 
9i Installation Guide Release 9.0.1 is located on the Oracle9i Online Generic 
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Documentation CD-ROM, Release 1 (9.0.1) cd-rom or you can get a free 
download of the manual from the Oracle Documentation Center at 
http://docs.oracle.com/.

Oracle Change Management Pack documentation

■ The Getting Started with Oracle Change Management Pack manual provides an 
overview of the concepts and features of the Oracle Change Management Pack 
applications.

Oracle Diagnostics Pack documentation

■ The Getting Started with the Oracle Diagnostics Pack manual provides an 
overview of the concepts and features of the Oracle Diagnostics Pack 
applications.

Oracle Management Pack for Oracle Applications documentation

■ The Getting Started with Oracle Management Pack for Oracle Applications provides 
an overview of the concepts and features of the applications provided with the 
Oracle Management Pack for Oracle Applications.

■ The Oracle Intelligent Agent User’s Guide provides configuration information and 
answers to crucial troubleshooting questions pertaining to the Oracle Intelligent 
Agent.

Oracle Management Pack for SAP R/3 documentation

■ The Oracle Management Pack for SAP R/3 Readme provides important notes 
regarding the Management Pack for SAP R/3 online documentation, updates to 
the software, and other late-breaking information. This manual is provided on 
the Oracle Enterprise Manager with Management Pack for SAP R/3 installation 
CD-ROM.

■ The Getting Started with Oracle Management Pack for SAP R/3 manual provides an 
overview of the concepts and features of the Oracle Performance Manager and 
Oracle Capacity Planner.  It also describes the Oracle Event Tests that are 
provided with the Oracle Management Pack for SAP R/3. This manual is 
provided on the Oracle Enterprise Manager with Management Pack for SAP 
R/3 installation CD-ROM. After the installation, this manual can be found by 
navigating to: Start=>Programs=>Oracle-ORACLE_ENTERPRISE_
MANAGER_HOME_NAME=>Management Pack for SAP 
R/3=>Documentation.

■ The Installation Guide for Oracle Enterprise Manager with Oracle Management Pack 
for SAP R/3 provides important information for installing the Oracle Enterprise 
Manager console and the Oracle Management Pack for SAP R/3. This manual 
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also contains information such as hardware and software requirements, 
installable components, and deinstallation procedures. This manual is provided 
on the Oracle Enterprise Manager with Management Pack for SAP R/3 
installation CD-ROM.

Oracle Standard Management Pack documentation

■ The Getting Started with Oracle Standard Management Pack manual provides an 
overview of the concepts and features of the Oracle Standard Management Pack 
applications.

Oracle Tuning Pack documentation

■ Database Tuning with the Oracle Tuning Pack provides an overview of the 
concepts and features of each of the applications in the Oracle Tuning Pack. The 
applications include Oracle SQL Analyze, Oracle Expert, Oracle Index Tuning 
Wizard, Reorg Wizard, and the Tablespace Map. A description of how these 
applications can work together to tune an Oracle database is also provided.

Obtaining Oracle Documentation

To download free release notes or installation information, please visit the Oracle 
Documentation Center at http://docs.oracle.com/

Printed documentation is available for sale in the Oracle Store at 
http://oraclestore.oracle.com/

Oracle Support
The Oracle Support Services OracleMetaLink site at  
(http://www.oracle.com/support/metalink/index.html) provides access to 
information that will aid you in using Oracle products such as: hot topics, product 
reference, installation assistance manuals, white papers, problem/solution articles, 
and more. To use this site you must be a licensed Oracle user with an active support 
service contract. Contact your Oracle sales representative for more information.
xvii
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Overview of the Oracle Management Pack for SA
1

Overview of the Oracle Management Pack

for SAP R/3

The SAP R/3 system is a powerful Enterprise Resource Planning (ERP) suite that 
improves coordination across internal activities and lines of businesses. The SAP 
R/3 system has a multi-tiered, distributed, and client/server based architecture that 
requires highly skilled and dedicated administrators. Managing the R/3 
environment on a day-to-day basis while planning for future needs is a complex, 
mission critical undertaking that requires management tools that match the power 
and robustness of SAP R/3.

By using the features of Oracle Enterprise Manager and the Oracle Management 
Pack for SAP R/3, you can more easily:

■ monitor your R/3 system

■ obtain trending information that will help you make accurate estimates of 
future resource requirements

■ detect problems that need to be corrected

Oracle Enterprise Manager
Oracle Enterprise Manager is the cornerstone for management within the Oracle 
environment. With a comprehensive set of system management tools, a job 
scheduling and event management system, and a centralized management console,  
Oracle Enterprise Manager offers a single point of control to manage and 
administer a distributed, heterogeneous environment. This integrated management 
solution saves time and money by significantly easing the burden incurred when 
deploying enterprise systems.  The new Oracle Management Pack for SAP R/3 
extends these same benefits to SAP deployments by integrating the R/3 system into 
Oracle Enterprise Manager.
P R/3 1-1



Centralized Administration
Centralized Administration
When the Oracle Management Pack for SAP R/3 is installed, the Oracle Enterprise 
Manager console is able to discover all SAP R/3 application servers and populate 
the console’s Navigator window and Map window with R/3 resources. These R/3 
resources can be viewed with the databases and platforms from the same 
environment.  All instances of an R/3 system can be viewed simultaneously. Also, 
multiple R/3 systems can be seen from the single console, which enables an 
administrator to centrally manage their entire R/3 environment.

Discovering an SAP R/3 System in the Enterprise Manager Console
Before you can discover one or more SAP R/3 systems running on Windows NT or 
UNIX, you must configure one or more NT proxy machines. See "Configuring the 
NT Proxy Machine to Manage SAP R/3 Data" on page 2-5 for information on 
configuring an NT proxy machine.

After you have properly configured an NT proxy machine, you can discover that 
machine in the Oracle Enterprise Manager console, and the SAP R/3 systems 
referred to in the NT proxy machine’s sap.conf file will be discovered in the console. 

To discover an NT proxy machine in the Oracle Enterprise Manager console, choose 
Discover Nodes on the Navigator menu, then specify the name of the NT proxy 
machine. Note that the Oracle 9.0.1 Agent must be running on the NT proxy 
machine in order for the Oracle Enterprise Manager console to discover the SAP 
R/3 system.

Figure 1–1 shows an R/3 system in the Navigator window of the Oracle Enterprise 
Manager console.
1-2 Getting Started with Oracle Management Pack for SAP R/3



Real-Time Monitoring
Figure 1–1 Viewing an SAP R/3 System in the Oracle Enterprise Manager Console

Real-Time Monitoring
With the Oracle Management Pack for SAP R/3, database administrators can 
determine the overall system health of their R/3 deployment. The Oracle 
Performance Manager application allows you to monitor all R/3 Application 
Servers, Application Instances, and their Work Processes. When you view Oracle 
Performance Manager charts that include statistics associated with each of these 
services, you can often drill down to display another chart with more information 
about the statistics, either on a per instance or aggregated basis.  Charts can display 
information in either tabular or graphical format.

For example, while looking at the instance summary of an R/3 system, an 
administrator may want to view overview information for the active work 
processes, then view the CPU usage for those work processes. This information is 
readily available in charts that can be viewed in Oracle Performance Manager. In 
addition to monitoring the R/3 system, one can also view detailed platform-specific 
information using the Oracle Management Pack for SAP R/3, providing a 
comprehensive understanding of overall system activity.

Figure 1–2 shows the Application Instance Overview chart, which displays statistics 
about application instances. When you click the right mouse button on a chart, you 
can display additional information about the selected item. In this example, when 
the Drilldown option is selected on the context menu, a Drilldown context menu is 
Overview of the Oracle Management Pack for SAP R/3 1-3



Capacity Planning
displayed. By selecting the Historical Data option from the Drilldown context 
menu, you can see a historical view of the data collected over a longer period of 
time. By selecting other options from the Drilldown context menu, you can view 
other charts that can provide additional information about the selected R/3 
application instance.

Figure 1–2 Obtaining More Information from a Performance Manager Chart

See Chapter 3, "Introduction to Oracle Performance Manager" for more information 
on using Oracle Performance Manager.

Capacity Planning
The Oracle Capacity Planner application enables you to save all monitored R/3 
system data for future planning purposes. With Oracle Capacity Planner, you can 
specify a small amount or a broad range of R/3-specific data to capture and 
maintain in full detail or to aggregate at periodic intervals. This historical data 
provides the trending information necessary to make accurate estimates of future 
resource requirements.  When viewed in conjunction with underlying database and 
platform-specific data gathered for the same period, R/3 system growth and 
changes can be correlated across the overall system to identify potential problems 
and take corrective action before they occur.

Figure 1–3 shows a collection of memory data being set up for an SAP R/3 
application instance using Oracle Capacity Planner.
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Figure 1–3 Setting Up a Collection of Historical Data for an SAP R/3 Application 
Instance

See Chapter 4, "Introduction to Oracle Capacity Planner" for more information on 
using Oracle Capacity Planner.

Event Integration
Oracle Management Pack for SAP R/3 provides a pre-defined R/3-specific Oracle 
Event Tests library to automatically detect error conditions.  The Event Tests 
provided with the Oracle Management Pack for SAP R/3 are integrated into the 
Oracle Enterprise Manager framework and can be combined with other Event Tests 
to detect conditions when monitored data exceeds a predetermined threshold. 
When an error condition occurs, an administrator, identified by job responsibility 
and work shift, is automatically notified via paging and/or email.

For example, the Bad Buffer Quality event test can be set up to notify you with a 
warning if the buffer hit ratio for an SAP buffer falls below 95%, and to notify you 
with an alert if the buffer hit ratio falls below 90%.
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See Chapter 5, "Introduction to SAP Event Tests" for more information on the SAP 
event tests and node event tests that are provided with Oracle Management Pack 
for SAP R/3.

Required Privileges
All Oracle Management Pack for SAP R/3 users must have the following profiles:

■ S_A.CPIC

■ S_A.SCON

■ S_A.SYSTEM

Compatibility and Availability
Oracle Management Pack for SAP R/3 supports releases 3.1 and above of SAP R/3 
and requires Oracle Enterprise Manager, version 2.2.

Key Classes of Data Monitored
With the Oracle Management Pack for SAP R/3, you can view the following data:

■ For the overall R/3 system:

– system at a glance

– overview data for the application instances

– detailed data for the application instances

– overview of the active work processes

– CPU usage for active work processes

■ For application instances:

– overview data about all buffers

– buffer quality data for all buffers

– buffer size data for all buffers

– overview data about memory

– detailed data about memory

– overview data about the roll area
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– overview data about the page area

– overview data about the extended memory

– overview data about the top reports

– detailed data about the top reports

– overview data about the work processes

– CPU overview data for the work processes

Key Features
■ Uses standard R/3 RFC calls to get the monitoring information for the SAP 

system

■ Centralized point of monitoring

■ Trending information
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Post-Installation Configuration

After you have installed the Oracle Management Pack for SAP R/3, you need to 
configure it in your environment.

This chapter provides:

■ an overview of the basic Oracle Enterprise Manager configuration

■ a description of a basic Oracle Management Pack for SAP R/3 configuration

■ detailed instructions on how to configure the Oracle Management Pack for SAP 
R/3 in your environment

Understanding the Basic Oracle Enterprise Manager Configuration
The basic Oracle Enterprise Manager configuration consists of the following nodes:

■ Client node

The node on which the Oracle Enterprise Manager console, Performance 
Manager, and Capacity Planner are installed.

■ Oracle Management Server (OMS) node

A node on which the Oracle Management Server for Oracle Enterprise Manager 
is running.

■ One or more managed nodes

 A managed node is a node on which you can:

– monitor real-time data using Oracle Performance Manager

– collect historical data that can be used for trending analysis using Oracle 
Capacity Planner
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– register event tests using the Oracle Enterprise Manager event system

Understanding the Oracle Management Pack for SAP R/3 Basic 
Configuration

You can use the Oracle Management Pack for SAP R/3 to manage:

■ SAP R/3 data on SAP R/3 systems

You must configure a Windows NT proxy machine (see "Configuring the NT 
Proxy Machine to Manage SAP R/3 Data" on page 2-5) to manage SAP data on 
SAP R/3 systems.

The 9i Intelligent Agent (Agent) that you install on a Windows NT proxy 
machine is used to discover SAP R/3 systems in the Oracle Enterprise Manager 
console and to register SAP event tests on those discovered SAP R/3 systems. 
Oracle Performance Manager uses the 9i Agent to monitor real-time SAP data, 
and Oracle Capacity Planner uses the 9i Agent to collect historical SAP data.

■ Node (operating system) data on nodes for which the Agent is available.

Note: In releases prior to 9i, the Agent data gathering service (also 
known as the Oracle Data Gatherer) was used to collect data for 
presentation in real-time performance monitoring utilities and 
historical data. The Agent and the data gathering service were 
separate services that were started and stopped independently of 
each other.

With 9i, the data collection capabilities are integrated into the 9i 
Intelligent Agent. Therefore, there is no separate service that needs 
to be started. Furthermore, when you stop the 9i Intelligent Agent, 
the data gathering capabilities are disabled and not available.

Important: Note that the SAP R/3 Agent extensions must be 
installed in the same Oracle Home as the 9i Agent on the NT proxy 
machine to enable the Agent to access SAP R/3 data. See 
"Configuring the NT Proxy Machine to Manage SAP R/3 Data" on 
page 2-5 for more information about the SAP R/3 Agent 
extensions.
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The Agent that you install on a node is used to discover the node in the Oracle 
Enterprise Manager console and to register node event tests on the node. When 
the Agent is running on a node, its collection services are used to  provide 
real-time node data to Oracle Performance Manager and historical node data to 
Oracle Capacity Planner.

In the sample Oracle Management Pack for SAP R/3 configuration shown in 
Figure 2–1, there is a Windows NT or UNIX machine on which SAP R/3 is not 
installed, an SAP R/3 system running on a Windows NT node, an SAP R/3 system 
running on a UNIX node, and an NT proxy machine that allows Oracle 
Management Pack for SAP R/3 to manage SAP data on the SAP R/3 systems.

Note: It is recommended that you install the 9i Agent on any node 
on which you want to register node event tests, view real-time 
node data, and collect historical node data.

If you are running an earlier version of the Agent on a node, you 
can monitor real-time node data and collect historical node data on 
that node only if both the Agent and the Agent data gathering 
service for that version of the Agent is running on the node.
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Figure 2–1 Oracle Management Pack for SAP R/3 Configuration with an NT Proxy 
Machine

In the sample configuration shown in Figure 2–1, after you correctly configure the 
Oracle Management Pack for SAP R/3, you can:

■ Register SAP event tests on nodes where SAP R/3 is running by using the 
Oracle Enterprise Manager event system

■ View real-time SAP data on nodes where SAP R/3 is running by using Oracle 
Performance Manager

■ Collect historical SAP data on nodes where SAP R/3 is running by using Oracle 
Capacity Planner

■ Register node (operating system) event tests on nodes by using the Oracle 
Enterprise Manager event system
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■ View real-time node (operating system) data on nodes by using Oracle 
Performance Manager

■ Collect historical node (operating system) data on nodes by using Oracle 
Capacity Planner

Configuring the Oracle Management Pack for SAP R/3
To configure the Oracle Management Pack for SAP R/3 to manage SAP data on SAP 
systems, you must properly configure the NT proxy machine. See "Understanding 
the NT Proxy Machine" on page 2-5 for more information.

To configure the Oracle Management Pack for SAP R/3 to manage node (operating 
system) data on nodes, you must configure access to those nodes. See "Configuring 
Access to Node Data on a Node" on page 2-9 for more information.

Understanding the NT Proxy Machine
Oracle Management Pack for SAP R/3 uses a specially configured Windows NT 
machine (known as the NT proxy machine) to:

■ Discover SAP R/3 systems

■ Register SAP event tests on SAP R/3 systems

■ Monitor real-time SAP data and historical SAP data on SAP R/3 systems

If you have a large number of SAP R/3 systems, you may choose to use multiple 
NT proxy machines to distribute the load among NT proxy machines.

Configuring the NT Proxy Machine to Manage SAP R/3 Data
To discover SAP R/3 systems in the Oracle Enterprise Manager console, monitor 
SAP real-time data, collect SAP historical data, and register SAP event tests on SAP 
R/3 systems, you must configure at least one NT proxy machine. Every NT proxy 
machine must be configured as follows:

1. On the NT proxy machine, make sure that the Oracle 9i Agent with the SAP 
R/3 extensions is installed and stopped.
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2. Make sure that the SAP RFC library for NT (librfc32.dll) for SAP version 4.6D is 
available in the ORACLE_HOME/bin directory for the 9i Agent on the NT 
proxy machine. Obtain this file from SAP. Read the following Note, which 
provides important information about the SAP RFC library for NT.

3. The Oracle Management Pack for SAP R/3 requires that msvcp60.dll file be 
present in a directory that is referenced by the NT proxy machine’s Path 
environment variable. Check the Path environment variable to make sure that it 
references the directory in which msvcp60.dll is present.

4. In the sap.conf file in the ORACLE_HOME/Network/Agent/Config folder for 
the 9i Agent on the NT proxy machine, enter the service names for the SAP R/3 
systems that you want the NT proxy machine’s 9i Agent to discover in the 
Oracle Enterprise Manager console. The service names for the SAP R/3 systems 
must be in the following format:

node-name sid system-number [language]

For example:

smpsmn3.de.oracle.com AT3 03 EN

Important: If the SAP R/3 Agent extensions have not been 
applied to the 9i Agent, it will not be able to access SAP R/3 data. 
See the Installation Guide for Oracle Enterprise Manager with 
Management Pack for SAP R/3 for more information about installing 
the Oracle 9i Agent and the SAP R/3 Agent extension.

Note: This product uses the RFC library (librfc32.dll) of SAP AG 
to connect to SAP software. Customers running SAP software on 
NT automatically have installed this library on their NT system. 
Non-NT customers need to obtain the RFC library for NT from the 
SAP support server.

This shared library is property of SAP AG. You are granted usage 
of this library in your development environment. Deploying this 
required library with your application in a production environment 
is only valid with the sufficient amount of SAP software licenses 
according to the terms and conditions of SAP software.
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For each service name, make sure that the node name of the SAP R/3 message 
server, the SAP R/3 system ID, the system number of the SAP R/3 instance 
running the message server, and the language key are separated by blanks or 
tabs.

Note that the language key is optional.

5. Start the Oracle 9i Agent on the NT proxy machine.

See "Managing the Agent on Windows NT" on page 2-11 for more information 
on managing the Agent on NT.

6. Start the Oracle Management Server. See "Managing the Oracle Management 
Server (OMS)" on page 2-13 for information on how to start the Oracle 
Management Server.

7. Start the Oracle Enterprise Manager console. See "Starting the Oracle Enterprise 
Manager Console" on page 2-15 for information on how to start the Oracle 
Management console.

8. In the Oracle Enterprise Manager console, discover the NT proxy machine:

a. Select the Discover Nodes item from the console’s Navigator menu to 
launch the Discovery Wizard.

b. Use the text window on Step 1 of the Discovery Wizard to enter the name of 
the node. You can discover multiple targets at one time by entering each 
node you want to discover on a new line within the text window.

c. Click Next, which causes the Discovery Wizard to start the discovery of the 
specified node or nodes.

To discover an NT proxy machine, the NT proxy machine must be up and it 
must be running the 9i Agent. You must also be using a TCP/IP network 
protocol.

When an NT proxy machine is discovered in the Oracle Enterprise Manager 
console, the SAP R/3 systems in the NT proxy machine’s sap.conf file are also 
discovered. Expand the SAP R/3 Systems folder in the console to view the SAP 
R/3 systems that are discovered. An SAP R/3 system that has been discovered 
in the Oracle Enterprise Manager console is referred to as a managed SAP R/3 
target. See "Discovering Nodes and Targets" on page 2-16 for more information 
on discovering a node.

9. If you do not plan on using the Oracle Enterprise Manager repository to store 
historical data collected by Oracle Capacity Planner, discover the Oracle 
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Capacity Planner historical database in the Oracle Enterprise Manager console 
by discovering the node on which the historical database is located.

See "Defining the Location of the Historical Database" on page 4-9 for more 
information on specifying the storage location for Oracle Capacity Planner 
historical data.

10. From the Oracle Enterprise Manager console, set preferred credentials for the 
NT proxy machine and for the SAP R/3 targets that were discovered when the 
NT proxy machine was discovered. See "Setting Preferred Credentials" on 
page 2-17 for information on setting preferred credentials. Setting preferred 
credentials for the NT proxy machine and all the discovered SAP R/3 targets is 
required for you to register SAP R/3 event tests on the SAP R/3 targets and to 
register node (operating system) event tests on the NT proxy machine. Also, 
after you perform this step, when you use Oracle Performance Manager while 
connected to the Oracle Enterprise Manager repository, all the discovered 
targets in the console are automatically displayed in the Oracle Performance 
Manager navigator tree, and you do not have to manually enter credentials for 
the targets.

You must configure at least one NT proxy machine to discover SAP R/3 systems in 
the Oracle Enterprise Manager console, to register SAP event tests on SAP R/3 
targets, and to monitor and collect real-time and historical SAP R/3 data on SAP 
R/3 targets.

Note: Note that if you use Oracle Performance Manager 
in standalone mode (not connected to the Oracle 
Enterprise Manager repository), you must:

1. Manually add any target on which you want 
to monitor data to the Oracle Performance 
Manager navigator tree.

2. Specify valid credentials for any targets on 
which you want to monitor data.

3. Enter the name of the node on which you 
want to collect data in the Host Logon dialog 
box.

Note that you cannot save recordings when you 
run Oracle Performance Manager in standalone 
mode.
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Discovering Additional SAP R/3 Systems in the Oracle Enterprise Manager 
Console
At some point after you have discovered some SAP R/3 systems, you may want to 
discover some additional SAP R/3 systems in the Oracle Enterprise Manager 
console. To do this, follow these steps:

1. Add the service names for the SAP R/3 systems to the sap.conf file on an NT 
proxy machine.

2. Stop and start the Agent on the NT proxy machine.

3. Refresh the discovery of the NT proxy machine in the Oracle Enterprise 
Manager console by clicking the NT proxy machine node in the navigator tree, 
then clicking Refresh Node on the Navigator menu.

These steps cause the additional SAP R/3 systems to appear as SAP targets in the 
Oracle Enterprise Manager console.

Removing an SAP R/3 Target from the Oracle Enterprise Manager Console
To remove an SAP R/3 target from the Oracle Enterprise Manager console, follow 
these steps:

1. Select the SAP R/3 target in the navigator tree, click the right mouse button, 
then choose Remove on the context menu.

2. Remove the service name for the SAP target from the sap.conf file on the NT 
proxy machine.

3. Stop and start the Agent on the NT proxy machine.

4. Refresh the discovery of the NT proxy machine in the Oracle Enterprise 
Manager console by clicking the NT proxy machine node in the navigator tree, 
then clicking Refresh Node on the Navigator menu.

These steps remove the SAP R/3 target from the Oracle Enterprise Manager 
console.

Configuring Access to Node Data on a Node
Using Oracle Management Pack for SAP R/3, you can:

■ Discover NT and UNIX nodes in the Oracle Enterprise Manager console

■ Register node (operating system) event tests on those discovered nodes
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■ Monitor real-time node (operating system) data on nodes using Oracle 
Performance Manager

■ Collect historical node (operating system) data on nodes using Oracle Capacity 
Planner

If you plan to use Oracle Management Pack for SAP R/3 to manage node (operating 
system) data on a node, then you need to perform the following steps to configure 
access for the node:

1. Install and start the Agent on the node to be managed. You can use the 9i Agent 
or any other supported version of the Agent to configure access to node data on 
the node. Note that if you are using a pre-9i Agent, you must also start the 
Agent data gathering service on the node.

The Agent on the node is used to discover the node in the Oracle Enterprise 
Manager console and to register node event tests on the node.

2. Start the Oracle Management Server. See "Managing the Oracle Management 
Server (OMS)" on page 2-13 for information on how to start the Oracle 
Management Server.

3. Start the Oracle Enterprise Manager console. See "Starting the Oracle Enterprise 
Manager Console" on page 2-15 for information on how to start the Oracle 
Management console.

4. From the Oracle Enterprise Manager console, discover the node on which you 
want to monitor node data. When the node is discovered in the console, the 
node will appear as a Node target in the console. See "Discovering Nodes and 
Targets" on page 2-16 for information on discovering a node.

5. If you do not plan on using the Oracle Enterprise Manager repository to store 
historical data collected by Oracle Capacity Planner, discover the Oracle 
Capacity Planner historical database in the Oracle Enterprise Manager console 
by discovering the node on which the historical database is located.

See "Defining the Location of the Historical Database" on page 4-9 for more 
information on specifying the storage location for Oracle Capacity Planner 
historical data.

6. From the Oracle Enterprise Manager console, set preferred credentials for the 
node. See "Setting Preferred Credentials" on page 2-17 for information on 
setting preferred credentials. This step is required for you to register node 
(operating system) event tests on the node. Also, after you perform this step, 
when you use Oracle Performance Manager in repository mode (connected to 
the Oracle Enterprise Manager repository), all the discovered targets in the 
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console are automatically displayed in the Oracle Performance Manager 
navigator tree, and you do not have to manually enter credentials for the 
targets.

Enabling Disk Statistics Collection for Performance Manager on Windows NT
If you want to use Oracle Performance Manager to collect disk statistics for an NT 
node, enable collection of the disk statistics by typing the following command at the 
MS-DOS prompt on the node:

diskperf -Y

Disk statistics are enabled the next time the system is restarted. For more 
information about the DISKPERF tool, refer to the Microsoft Windows NT 
documentation.

Managing the Agent
The Agent must be running before you can discover nodes and targets from the 
Oracle Enterprise Manager console and before you can register event tests on a 
target.

Note that:

■ The 9i Agent is required to manage SAP R/3 data on SAP R/3 systems, as 
follows:

To manage an SAP R/3 system, make sure that the 9i Agent is installed and 
running on the NT proxy machine for the SAP R/3 system.

■ To manage node data on an NT or UNIX node, make sure that a supported 
version of the Agent is installed and running on the node.

Managing the Agent on Windows NT
On Windows NT, the Agent runs as a Windows NT service. Table 2–1 describes how 
to manage the Agent on Windows NT.

Note: Enabling disk statistics is not required. You can still monitor 
other operating system statistics with Performance Manager even if 
disk statistics are not enabled.
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The Agent Startup Type is set by default to Manual, which allows the Agent to be 
started by a user. If you want the Agent to start automatically whenever you start 
the system, set the Startup Type to Automatic. Refer to the Oracle Intelligent Agent 
User’s Guide for additional information.

Managing the Agent from the Windows NT Command Prompt
To start or stop the Agent from the command prompt, enter the appropriate 
command. From the command prompt, you can also verify that the Agent is 
running.

Table 2–2 describes how to manage the Agent on Windows NT from the Windows 
NT command prompt.

Table 2–1 Managing the Agent on Windows NT 

If you want to... Do the following...

Start the Agent on NT Choose Start->Settings->Control 
Panel->Services->Oracle<name-of-ORACLE_
HOME>->Agent->Start

Stop the Agent on NT Choose Start->Settings->Control 
Panel->Services->Oracle<name-of-ORACLE_
HOME>->Agent->Stop

Verify the status of the 
Agent on NT

Choose Start->Settings->Control Panel->Services->Oracle 
<name-of-ORACLE_HOME>->Agent and look at the Status 
column

or

View the Windows NT Task Manager to see the dbsnmp 
process information

Table 2–2 Managing the Agent on Windows NT from the Command Prompt 

If you want to... Enter the following command...

Start the Agent from the 
command prompt

net start agent-service

Stop the Agent from the 
command prompt

net stop agent-service

Verify status of the Agent 
from the command 
prompt

net start
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The agent-service is composed of the word "Oracle", followed by the name of the 
Oracle home (for example, OUIHome), and concluded with the word "Agent" with a 
number attached. OracleOUIHomeAgent80, is an example of an agent service.

The log file for the 9i Agent is dbsnmp.log. The dbsnmp.log file is written to the 
ORACLE_HOME\network\log directory in the Agent’s Oracle Home.

Managing the Agent on UNIX
On UNIX, Oracle Enterprise Manager uses the agentctl command to start and 
stop the Agent. Table 2–3 describes the agentctl commands for managing the 
UNIX Agent.

The log file for the 9i Agent is dbsnmp.log. The dbsnmp.log file is written to the 
ORACLE_HOME/network/log directory in the Agent’s Oracle Home.

Managing the Oracle Management Server (OMS)
The Oracle Management Server (OMS) can be installed on Windows NT and UNIX 
nodes. The Oracle Management Server must be running before you can start the 
Oracle Enterprise Manager console and discover nodes and targets.

Note: Verify that your ORACLE_HOME environment variable is 
set to the Agent’s ORACLE_HOME before running agentctl.

Table 2–3 Managing the Agent on UNIX 

If you want to... Enter the command...

Start the Agent on the 
UNIX platform

agentctl start agent

Stop the Agent on the 
UNIX platform

agentctl stop agent

Verify status of the Agent 
on the UNIX platform

agentctl status agent or ps -ef|grep "dbsnmp"

Turn on debugging for 
data collection

1. setenv VP_DEBUG 1

2. agentctl start agent

Collection activity is logged into dbsnmp.nohup
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Managing the Oracle Management Server on Windows NT
On Windows NT, the Oracle Management Server runs as a Windows NT service. 
Table 2–4 describes how to manage Oracle Management Server on Windows NT.

Managing the Oracle Management Server on UNIX
On UNIX, Oracle Enterprise Manager uses the oemctl command to start and stop 
the Oracle Management Server. Table 2–5 describes the oemctl commands to 
control the Oracle Management Server on UNIX. In all cases, the command string is 
case-sensitive and must be entered with lowercase characters.

Table 2–4 Managing the Oracle Management Server on Windows NT 

If you want to... Do the following...

Start the Oracle 
Management Server

Choose Start->Settings->Control Panel->Services->Oracle 
<name of ORACLE HOME> ManagementServer->Start

Stop the Oracle 
Management Server

Choose Start->Settings->Control Panel->Services->Oracle 
<name of ORACLE HOME> ManagementServer->Stop

Verify the status of the 
Oracle Management 
Server

Choose Start->Settings->Control Panel->Services->Oracle 
<name of ORACLE HOME> ManagementServer and look at 
the Status column

Table 2–5 Managing the Oracle Management Server on UNIX 

If you want to... Enter the command...

Start the Oracle 
Management Server

oemctl start oms

NOTE: To start the Oracle Management Server as a 
background process, type:

oemctl start oms &

Stop the Oracle 
Management Server

oemctl stop oms <EMAdministratorName>/<EMPassword> 
where:

EMAdministratorName is your Oracle Enterprise Manager super 
administrator name.

EMPassword is your Oracle Enterprise Manager super 
administrator password. EMPassword is case-sensitive and 
must be entered in the same case as it was originally entered.
2-14 Getting Started with Oracle Management Pack for SAP R/3



Starting the Oracle Enterprise Manager Console
The status information of the Oracle Management Server includes the following:

■ Overall status of the Oracle Management Server

■ Time period the Oracle Management Server has been up and available

■ Statistics regarding the performance of the Oracle Management Server

Starting the Oracle Enterprise Manager Console
Follow these steps to start the Oracle Enterprise Manager console:

1. On Windows NT, start the Oracle Enterprise Manager console from the 
Windows Start menu as follows:

Start=>Programs=>Oracle<name of Oracle Enterprise Manager ORACLE_HOME>Oracle 
Enterprise Management=>Enterprise Manager Console

On UNIX, start the console from the command line by typing

oemapp console

The command string is case-sensitive and must be entered with lowercase 
characters. 

2. If you are logging in to the console for the first time, after the first login dialog 
appears, type in the default credentials for the super administrator account. 

Administrator = sysman

Password = oem_temp

Verify the status of the 
Oracle Management 
Server

oemctl status oms 
<EMAdministratorName>/<EMPassword>[@<hostname>] where:

EMAdministratorName is your Oracle Enterprise Manager super 
administrator name.

EMPassword is your Oracle Enterprise Manager super 
administrator password. EMPassword is case-sensitive and 
must be entered in the same case as it was originally entered.

hostname is the machine where your Oracle Management 
Server is running. You do not need to enter the hostname if the 
Oracle Management Server is running locally.

Table 2–5 Managing the Oracle Management Server on UNIX (Cont.)

If you want to... Enter the command...
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3. Select an Oracle Management Server which is configured with the repository 
that you want to access from the Management Server pull-down list.

If the Oracle Management Server you want to use does not appear, do the 
following:

a. Click the Management Servers button. The Management Servers dialog 
appears. 

b. Click the Add button. The Add Management Server dialog appears. 

c. Type in the name of the node on which the Oracle Management Server that 
you want to add is running and click OK. 

d. Select the Oracle Management Server from the pull-down list.

4. After the initial login, a security login dialog appears where you can change 
your super administrator account password. You should change the password 
immediately. 

Discovering Nodes and Targets
When the Oracle Management Server starts up, it connects to the Oracle Enterprise 
Manager repository and obtains information about discovered targets. The Oracle 
Enterprise Manager console navigator displays all the discovered targets from the 
Oracle Management Server machine.

To discover a node from the console:

1. Select the Discover Nodes item from the console’s Navigator menu. 

2. Use the text window on Step 1 of the Discovery Wizard to enter the name of the 
node. You can discover multiple targets at one time by entering each node you 
want to discover on a new line within the text window.

3. Click Next, which causes the Discovery Wizard to start the discovery of the 
specified node or nodes.

To discover a node, the node must be up and it must be running the Agent. You 
must also be using a TCP/IP network protocol.

After discovering a node, you should see a Nodes folder in the navigator tree of the 
Oracle Enterprise Manager console.

Note: Passwords must have no more than 8 characters. 
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After you discover an NT proxy machine, the SAP R/3 systems whose service 
names are in the NT proxy machine’s sap.conf file will be discovered and appear as 
SAP targets in the SAP R/3 Systems folder in the navigator tree of the Oracle 
Enterprise Manager console. See "Configuring the NT Proxy Machine to Manage 
SAP R/3 Data" on page 2-5 for information on configuring an NT proxy machine.

If you do not see these folders when discovering these targets, verify that your 
configuration of the node was successful (see "Configuring Access to Node Data on 
a Node" on page 2-9) and then rediscover the target from the console.

Setting Preferred Credentials
To register SAP event tests on SAP R/3 managed targets and to register node events 
on NT or UNIX managed nodes, you must enter preferred credentials for these 
targets.  The Agent uses these credentials when registering events on the managed 
targets. You may also want to set preferred credentials for targets on which you 
want to monitor real-time data and collect historical data. If you do not specify 
preferred credentials for these targets, you will have to manually enter credentials 
each time you connect to the targets using Oracle Performance Manager or Oracle 
Capacity Planner.

To enter preferred credentials for a managed target, select 
System=>Preferences=>Preferred Credentials in the Oracle Enterprise Manager 
console for the target.

You need to enter preferred username and password credentials for a node.

You need to enter the following preferred credentials for an SAP R/3 system:

■ Username

Your username for the SAP R/3 system to which you want to connect.

■ Password

Your password for the SAP R/3 system.

■ SAP R/3 Client

SID (SAP system identification) of the SAP R/3 system.

Starting Applications in the Oracle Management Pack for SAP R/3
After starting the Oracle Enterprise Manager console, you can start the applications 
in the Oracle Management Pack for SAP R/3.
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For more information on starting Oracle Performance Manager, see "Starting Oracle 
Performance Manager" on page 3-4.

For more information on starting Oracle Capacity Planner, see "Starting Oracle 
Capacity Planner" on page 4-3.

A Sample Oracle Management Pack for SAP R/3 Configuration
Figure 2–2 shows a sample Oracle Management Pack for SAP R/3 configuration.
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Figure 2–2 Oracle Management Pack for SAP R/3 Sample Configuration
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The following nodes appear in Figure 2–2:

■ Node C

This is the client node. The Oracle Enterprise Manager console, Performance 
Manager, and Capacity Planner are installed on this machine. The client node 
must be a Windows NT or Windows 2000 machine.

■ Node CP

This node contains the Oracle Capacity Planner historical database, which 
stores historical data collected by Oracle Capacity Planner.

In this sample configuration, you must discover the historical database in the 
Oracle Enterprise Manager console to enable storage of historical data in the 
database.

If you use the Oracle Enterprise Manager repository as the historical database, 
the discovery of the historical database is unnecessary.

■ Node N

This is the NT proxy machine, which is used to manage SAP R/3 data on the 
SAP R/3 systems on Node 3, Node 4, and Node 5. See "Configuring the NT 
Proxy Machine to Manage SAP R/3 Data" on page 2-5 for information about the 
configuration of this NT proxy machine.

In this sample configuration, an SAP R/3 system is not installed on the NT 
proxy machine. However, you are not restricted from configuring an NT node 
on which an SAP R/3 system is installed as an NT proxy machine.

■ Node 1

This is an NT machine on which the Agent is running.

After this node has been discovered in the Oracle Enterprise Manager console, 
you can:

– Register node event tests

– Monitor real-time node data using Performance Manager

– Collect historical node data using Capacity Planner.

■ Node 2

This is a UNIX machine on which the Agent is running.

After this node has been discovered in the Oracle Enterprise Manager console, 
you can:
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– Register node event tests

– Monitor real-time node data using Performance Manager

– Collect historical node data using Capacity Planner.

■ Node 3

This is an NT machine on which an SAP R/3 system that uses an Oracle 
database is running. The Agent is running on this node.

The service name of the SAP R/3 system on this node is included in the 
sap.conf file of the NT proxy machine (Node N). The 9i Agent that is running 
on the NT proxy machine is used to manage SAP data on Node 3.

After this node has been discovered in the Oracle Enterprise Manager console, 
you can:

– Register SAP event tests for the SAP R/3 target

– Monitor real-time SAP data using Performance Manager

– Collect historical SAP data using Capacity Planner.

– Register node event tests

– Monitor real-time node data using Performance Manager

– Collect historical node data using Capacity Planner.

■ Node 4

This is a UNIX machine on which an SAP R/3 system that uses an Oracle 
database is running. The Agent is running on this node.

The service name of the SAP R/3 system on this node is included in the 
sap.conf file of the NT proxy machine (Node N). The 9i Agent that is running 
on the NT proxy machine is used to manage SAP data on Node 4.

After this node has been discovered in the Oracle Enterprise Manager console, 
you can:

– Register SAP event tests for the SAP R/3 target

– Monitor real-time SAP data using Performance Manager

– Collect historical SAP data using Capacity Planner.

– Register node event tests

– Monitor real-time node data using Performance Manager
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– Collect historical node data using Capacity Planner.

■ Node 5

This is a UNIX machine on which an SAP R/3 system that uses an Oracle 
database is running. The Agent on this node is not running.

The service name of the SAP R/3 system on this node is included in the 
sap.conf file of the NT proxy machine (Node N). The 9i Agent that is running 
on the NT proxy machine is used to manage SAP data on Node 5.

After this node has been discovered in the Oracle Enterprise Manager console, 
you can:

– Register SAP event tests for the SAP R/3 target

– Monitor real-time SAP data using Performance Manager

– Collect historical SAP data using Capacity Planner.

Because the Agent is not installed on this node, you cannot do the following on 
the node:

– Register node event tests

– Monitor real-time node data using Performance Manager

– Collect historical node data using Capacity Planner.

■ Node O

This can be either an NT or UNIX machine on which the Oracle Management 
Server for Oracle Enterprise Manager is running.

■ Node R

This node contains the Oracle Enterprise Manager repository. The repository 
can be created in any Oracle database on any system. See the Oracle Enterprise 
Manager Configuration Guide for more information on setting up the repository.

One or more Oracle Management Servers can use the same repository.

Table 2–6 shows the operations that can be performed on each of the managed 
nodes in the sample configuration in Figure 2–2:
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Summary of Configuration Requirements for Managing SAP R/3 and Node Data
Table 2–7 summarizes the configuration requirements for managing SAP R/3 data 
on SAP R/3 systems.

Table 2–6 Operations That Can be Performed on the Managed Nodes in Figure 2–2  

Name of 
Managed 
Node

Monitor and Collect SAP R/3 
Data and Register SAP R/3 
Events 

Monitor and Collect Node 
(Operating System) Data and 
Register Node Events 

Node N No Yes

Node 1 No Yes

Node 2 No Yes

Node 3 Yes Yes

Node 4 Yes Yes

Node 5 Yes No

Table 2–7 Configuration Requirements for Managing SAP R/3 Data on SAP R/3 
Systems 

Task

Must the SAP R/3  
Target Be 
Discovered in the 
Console?

Must the Agent Be 
Running on the 
Node Where the 
SAP R/3 Target is 
Running?

Viewing real-time 
SAP data using 
Oracle Performance 
Manager

No1 No

Collecting historical 
SAP data using 
Oracle Capacity 
Planner

No2 No

Registering SAP 
event tests

Yes Yes
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Table 2–8 summarizes the configuration requirements for managing node 
(operating system) data on managed nodes.

1 You can view real-time SAP data in Performance Manager without first 
discovering the SAP R/3 target in the console. However, each time you 
want to view SAP data on the target using Performance Manager, you 
will need to manually add the SAP R/3 target to the Performance 
Manager navigator and specify credentials for the target. If you discover 
the SAP R/3 target in the console, specify preferred credentials for the 
target, and then always use Performance Manager in repository mode 
(connected to the Oracle Enterprise Manager repository), the target will 
always appear in the Performance Manager navigator and you will not 
need to manually enter credentials to view real-time SAP data on the 
target.

2 You can view historical SAP data in Capacity Planner without first 
discovering the SAP R/3 target in the console. However, each time you 
want to view SAP data on the target using Capacity Planner, you will 
need to manually add the SAP R/3 target to the Capacity Planner 
navigator and specify credentials for the target. If you discover the SAP 
R/3 target in the console and specify preferred credentials for the target, 
the target will always appear in the Capacity Planner navigator and you 
will not need to manually enter credentials to view historical SAP data on 
the target.

Table 2–8 Configuration Requirements for Managing Node Data on Managed Nodes 

Task

Must the Node Be 
Discovered in the 
Console?

Must the Agent Be 
Running on the 
Node?

Viewing real-time 
node data

No1

1 You can view real-time node data in Performance Manager without first 
discovering the node in the console. However, each time you want to 
view node data on the node using Performance Manager, you will need 
to manually add the node to the Performance Manager navigator and 
specify credentials for the node. If you discover the node in the console, 
specify preferred credentials for the node, and then always use 
Performance Manager in repository mode (connected to the Oracle 
Enterprise Manager repository), the node will always appear in the 
Performance Manager navigator and you will not need to manually enter 
credentials to view real-time node data on the node.

No

Collecting historical 
node data

No2 No

Registering node 
event tests

Yes Yes
2-24 Getting Started with Oracle Management Pack for SAP R/3



A Sample Oracle Management Pack for SAP R/3 Configuration
Other Possible Configurations
Figure 2–2 shows the Oracle Enterprise Manager client, Oracle Enterprise Manager 
repository, Oracle Management Server, NT proxy machine with 9i Agent, and 
Capacity Planner historical database on separate nodes. This is just one possible 
configuration. Each of these components is not required to be on a separate node. 
You can also use any of the following configuration options:

■ Install or create the components on a single NT node

Install or create the components on several NT nodes. For example, you could 
install the Oracle Enterprise Manager client and Oracle Capacity Planner historical 
database on one NT node, the Oracle Management Server and Oracle Enterprise 
Manager repository on another node, and the NT proxy machine with the 9i Agent 
on another NT node. As long as each node is configured properly for each of the 
components on it, you can configure the Oracle Management Pack for SAP R/3 as 
you like.

2 You can view historical node data in Capacity Planner without first 
discovering the node in the console. However, each time you want to 
view node data on the node using Capacity Planner, you will need to 
manually add the node to the Capacity Planner navigator and specify 
credentials for the node. If you discover the node in the console and 
specify preferred credentials for the node, the node will always appear in 
the Capacity Planner navigator and you will not need to manually enter 
credentials to view historical node data on the node.
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3

Introduction to Oracle Performance

Manager

Oracle Performance Manager is an Oracle Enterprise Manager application that 
allows you to monitor the performance of the database and its related applications 
and operating systems in real time. It allows system and database administrators to 
monitor performance statistics for Oracle database servers, web servers, Oracle 
concurrent managers, operating systems, and other managed targets. Performance 
Manager also allows you to record statistics and play them back at a later time.

You can display these statistics in a number of formats including horizontal and 
vertical tables, strip charts, horizontal and vertical bar charts, and pie charts. You 
can also drill down for more detail on some predefined charts.

Since Performance Manager is integrated with Oracle Capacity Planner, you can 
also drill down to an historical view of the displayed data. The drilldown to 
historical data allows you to quickly compare the current real time value with the 
historical average to provide you with a better understanding of the meaning of the 
current value. For more information about Capacity Planner, see Chapter 4, 
"Introduction to Oracle Capacity Planner".

For most targets, Performance Manager integrates Event system thresholds with 
charts so that events and charts share common performance thresholds you can set 
from either monitoring point. This provides consistent monitoring of thresholds 
across Enterprise Manager and allows access to graphical and historical diagnostics 
information from the Event system. You can investigate event notifications by 
launching charts, historical data and diagnostic advice directly from the Event 
Viewer. Performance Manager charts incorporate event notification through chart 
threshold state indicators. Performance Manager threshold and event features are 
available for node and database data.
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Oracle Performance Manager uses the Intelligent Agent (Agent) to collect 
performance data. To monitor some types of data, you must install the Agent on the 
system (or systems) where you want to monitor data. To monitor SAP data for an 
SAP R/3 target, the Agent on the NT proxy machine for the target is used. See 
"Configuring the NT Proxy Machine to Manage SAP R/3 Data" on page 2-5 for 
information on configuring the NT proxy machine to manage SAP data on an SAP 
target. 

If you are using Oracle Performance Manager to monitor database performance, the 
Agent can be installed on another system (note that you must have the Oracle 
Diagnostics Pack to monitor database data).  

The types of performance data that Oracle Performance Manager can monitor on a 
system depends on the products that are installed. Table 3–1 shows the types of 
data (or targets) that Oracle Performance Manager can monitor when various 
Oracle products are installed. 

Note: In releases prior to 9i, the Agent data gathering service (also 
known as the Oracle Data Gatherer) was used to collect data for 
presentation in real-time performance monitoring utilities and 
historical data. The Intelligent Agent and the data gathering service 
were separate services that were started and stopped 
independently of each other.

With 9i, the data collection capabilities are integrated into the 9i 
Intelligent Agent. Therefore, there is no separate service that needs 
to be started. Furthermore, when you stop the 9i Intelligent Agent, 
the data gathering capabilities are disabled and not available.

Table 3–1 Data that Performance Manager Can Monitor when Various Oracle Products 
Are Installed 

Oracle 
Product

Oracle 
Concurrent 
Manager Data

Oracle 
Server 
Data

Operating 
System Data

SAP R/3 
System 
Data

Microsoft 
SQL 
Server 
Data

Diagnostics 
Pack

No Yes Yes No Yes

Management 
Pack for 
Oracle 
Applications

Yes No Yes No No
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Usage Scenarios for Oracle Performance Manager
If additional products from Oracle or other vendors are installed, Oracle 
Performance Manager may be able to monitor additional types of data not shown in 
Table 3–1.

Usage Scenarios for Oracle Performance Manager
Using Oracle Performance Manager, you can:

■ Monitor one or more targets concurrently.

■ View the monitored data in various chart formats, including strip (line), pie, 
bar, table, and hierarchical.

■ Set the refresh rate for a chart’s data.

■ View multiple charts concurrently for each monitored target.

■ View multiple charts in a single window.

■ Drill down from one chart to another related chart. Drill down to diagnostic 
advice.

■ Drill down from real-time chart data to historical chart data.

■ Choose the collected data and data sources to display in a chart.

■ View threshold state indicators that provide immediate visual notification of 
performance status for specific targets. This feature is available for nodes and 
databases.

■ Print a chart.

Management 
Pack for SAP 
R/3

No No Yes Yes No

Standard 
Management 
Pack (Oracle 
Standard 
Edition only)

No Yes Yes No Yes

Table 3–1 Data that Performance Manager Can Monitor when Various Oracle Products 
Are Installed (Cont.)

Oracle 
Product

Oracle 
Concurrent 
Manager Data

Oracle 
Server 
Data

Operating 
System Data

SAP R/3 
System 
Data

Microsoft 
SQL 
Server 
Data
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■ Generate and publish an HTML report for a chart.

■ Display context-sensitive help for a chart, if help is available for the chart.

■ Play a recording of a chart, with fast-forward and pause features.

Starting Oracle Performance Manager
You can start Oracle Performance Manager from the Oracle Enterprise Manager 
console, from the UNIX command line, or from the Windows Start menu. 

Starting Oracle Performance Manager from the Console
You can start Oracle Performance Manager from the Oracle Enterprise Manager 
console in any of the following ways:

■ On the Oracle Enterprise Manager console, point to the SAP R/3 Management 
drawer, then click Performance Manager.

■ On the Tools menu of the Oracle Enterprise Manager console, point to SAP R/3 
Management, then click Performance Manager.

■ Click the right mouse button on the target for which you want to start 
Performance Manager and then choose Performance Manager from the Related 
Tools menu item on the context menu.

Starting Oracle Performance Manager from the UNIX Command Line
To start Performance Manager from the UNIX command line, set default to the 
ORACLE_HOME/bin directory, then type the following command:

./oemapp pm

Note: When you start Oracle Performance Manager from the 
Oracle Enterprise Manager console, Oracle Performance Manager 
connects to the Oracle Management Server using the same 
credentials used to start the Oracle Enterprise Manager console.
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When you start Performance Manager from the UNIX command line, you are given 
a choice of logging in to the Oracle Management Server and running Performance 
Manager in Enterprise mode or Standalone mode.

See "Running Performance Manager in Enterprise Mode" on page 3-5 and "Running 
Performance Manager in Standalone Mode" on page 3-6 for more information about 
running Performance Manager in Enterprise mode and Standalone mode.

Starting Oracle Performance Manager from the Start Menu in Windows NT
On the Start menu of Windows NT, follow the path: Start=>Programs=>ORACLE_
HOME=>Management Pack for SAP=>Performance Manager.

When you start Performance Manager from the Start menu, you are given a choice 
of logging in to the Oracle Management Server and running Performance Manager 
in Enterprise mode or Standalone mode.

Running Performance Manager in Enterprise Mode
To run Oracle Performance Manager in Enterprise mode:

1. Click Login to the Oracle Management Server.

2. Enter the appropriate connection information for your Oracle Management 
Server.

To select an alternate Management Server, click the Management Server button 
next to the Management Server drop-down list.  In the resulting dialog box, 
you can add another node that is running Oracle Management Server software. 
The Oracle Management Server and its associated repository must already 
exist.

For information on the fields in the Management Servers dialog box, click Help.

3. Click OK.

Note: ORACLE_HOME represents the home directory in which 
the Oracle Management Pack for SAP R/3 is installed.

Note: ORACLE_HOME represents the home directory in which 
the Oracle Management Pack for SAP R/3 is installed.
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When Performance Manager is running in Enterprise mode and the navigator is 
first displayed with a target type folder expanded, the targets of that type that were 
discovered in the Enterprise Manager console are displayed. When you expand a 
target, Performance Manager attempts to connect to the target. When the target is 
an SAP R/3 system and preferred credentials for the SAP R/3 system have been 
saved in the Oracle Enterprise repository, Performance Manager attempts to 
connect to the SAP R/3 system using those credentials. Otherwise, the SAP Logon 
dialog box prompts you for the logon information.

Running Performance Manager in Standalone Mode
To run Oracle Performance Manager in standalone mode (not connected to the 
Oracle Enterprise Manager repository), click Standalone, no repository connection, 
then click OK.

When Performance Manager is running in Standalone mode Performance Manager 
displays any targets that were added to the console in Standalone mode. You can 
add nodes or databases to the collection view for the current standalone mode 
session only. Click on the Add Service toolbar button after selecting the folder for 
the desired target type.

Using the Oracle Performance Manager Main Window
The primary component of the Oracle Performance Manager user interface is the 
main window (see Figure 3–1), which contains two panels. The navigator or tree 
panel appears on the left side of the main window and the property sheet panel 
appears on the right side. When you select an item in the navigator panel, the 
property sheet panel displays the properties of the selected item.

Note: If the repository was created using Enterprise Manager  
Release 2.1 or earlier, you must upgrade the repository or create a 
new repository.  For more information, see the Oracle Enterprise 
Manager Configuration Guide.

Note: Your recordings and user-defined charts will not be saved 
in Standalone mode. If you exit Performance Manager, you will not 
be able to play back any recordings or access these user-defined 
charts in future sessions. You will also not be able to save any chart 
settings or custom charts.
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When you first start Oracle Performance Manager, the navigator panel displays the 
target type folders and the property sheet panel displays the Performance Manager 
welcome screen.

A vertical toolbar appears on the left side of the window and a menu bar appears 
across the top of the window.  For more information about the buttons in the 
toolbar and the commands available from the Performance Manager menus, choose 
Window from the Performance Manager Help menu.

In the navigator panel, the Network folder contains a folder for each target type. 
For example, when you have the Oracle Management Pack for SAP R/3 installed, 
the target types can include Nodes and SAP R/3 Systems. To monitor the 
performance of database targets, you must have the Oracle Diagnostics Pack 
installed.  Not all target types may be available on all systems.

In addition to the Network folders, the Recordings folder contains any recordings 
of chart data that exist. For more information about the Recordings folder, see 
"Recording Chart Data" on page 3-22.
Introduction to Oracle Performance Manager 3-7



Using the Oracle Performance Manager Main Window
Oracle Performance Manager Main Window

Connecting to a Discovered Target in Enterprise Mode
Expand a target type folder to view the corresponding targets previously 
discovered through the Oracle Enterprise Manager console.

To connect to a discovered target, select the target in the navigator tree and click 
Connect to service in the Performance Manager toolbar, or click the plus sign (+) 
next to the target in the navigator. You can also connect to the target by double 
clicking on it in the navigator tree . You may be prompted with a Logon dialog box 
if credentials are required to connect to the target. For information on the fields in 
the Logon dialog box, click Help.

Manually Connecting to a Target
You can manually add additional targets that have not been discovered using the 
Enterprise Manager console.
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To add and connect to a target manually:

1. Select the folder for the target type you are adding.

2. Click Add Service in the Performance Manager toolbar panel.

Performance Manager displays a Logon dialog box.

3. Fill in the fields in the Logon dialog box and click OK.  

For information on the fields in the Logon dialog box, click Help.

After you connect to a target, Performance Manager displays the classes of 
performance information you can monitor for the selected target. Expand a class to 
see the individual performance data charts available for the selected class.

Viewing Performance Manager Charts
You can display a chart using one of the following methods:

■ Select the chart in the navigator, and click the Show Chart button on the 
toolbar.

■ Select the chart in the navigator, and choose Show Chart from the Chart menu.

■ Select the chart in the navigator, which displays the chart’s property sheet. To 
start the chart with the selected property sheet options, click Show Chart on the 
property sheet.

■ Select a chart class, then select the chart in the Predefined Displays list and 
click Show Chart.

■ Select the chart in the navigator and click the right mouse button.  From the 
context menu, click Show Chart.

Performance Manager displays each chart or chart group in its own window, which 
is separate from the main window. This window is called the Chart Display 
window.  For more information, see "Using the Chart Display Window" on 
page 3-12.

Note: When you add a target manually to the navigator tree using 
the Add Service button, you are adding that target for the current 
session of Performance Manager only.  You can begin collecting 
data for the target, but if you exit and restart Performance Manager, 
you will have to add the target again.
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Monitoring Multiple Targets Concurrently
You can view charts from multiple targets concurrently by connecting to the targets 
from the navigator tree and displaying charts.

Viewing Chart Groups
Some types of data include a chart group, which is two or more charts that are 
displayed within a single Chart Display window. You display a chart group the 
same way as you view any other chart (see "Viewing Performance Manager Charts" 
on page 3-9).

You can display a special chart group that contains the Overview Charts for a 
selected target:

1. Select a target in the Performance Manager navigator.

2. Click the Show Overview Charts button in the toolbar panel.

Performance Manager displays a chart group containing some key statistics 
most likely of interest to database administrators monitoring the selected target. 

Charts in a chart group are displayed within a single window. You perform actions, 
such as setting options and displaying drilldown charts, on one chart at a time 
within a chart group. The currently selected chart within a chart group window is 
identified by a highlighted title or a black box. For example, the Memory Faults 
chart is the currently selected chart in Figure 3–1.
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Figure 3–1 Identifying the Selected Chart In a Chart Group

Besides viewing the Overview Charts for a selected target, you can also view a chart 
group provided with a data class.  For example, you can select the Memory data 
class for a Windows NT node and display the Memory at a Glance chart group. Not 
all data classes provide chart groups, however.

Selecting Collected Data and Data Sources
For some charts, the chart’s property sheet allows you to select the collected data to 
display and the data sources for which the collected data should be displayed.

The collected data are the statistics that can be monitored and displayed in the 
chart. The data sources are the items from which Oracle Performance Manager is 
able to collect the data. For example, the data source of disk statistics may be disk1 
or disk2, and the data source of file statistics may be file1 or file2.

By clicking in the column next to the name of the collected data or the name of the 
data source in the chart property sheet, you can specify whether or not to monitor 
that collected data or data source and display it in the chart. 

When a green check mark appears in the column, Oracle Performance Manager will 
display that collected data or data source in the chart. If you click in the column 
again, the check mark goes away, which indicates that Oracle Performance Manager 
will not display that collected data or data source. You can toggle back and forth 
between monitoring and not monitoring all the collected data or data sources by 
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clicking in the column head. If the check mark is gray, it means Oracle Performance 
Manager will display the collected data or data source, and you are unable to 
change the selection of this data.

If the chart definition contains default data source or collected data attributes, then 
those items are preselected in the chart’s property sheet.

Using the Chart Display Window
When you display a chart, Oracle Performance Manager opens the Chart Display 
window.  The window contains its own toolbar and menu bar. For information 
about the Chart Display window, choose Window from the Chart Display window 
Help menu.

Selecting a Chart Format
To change the format of the chart, click on the Chart Format button in the Chart 
Display window toolbar and select the format in which you want to display the 
chart from the list that displays. 

For example, suppose a chart initially displays as a bar chart.  To see the data as a 
pie chart, choose Pie Chart from the list that displays when you click on the Chart 
Format button in the toolbar.  You can also display a chart in one of the additional 
formats:

■ Bar (vertical or horizontal orientation)

■ Strip (or line chart)

■ Table (vertical or horizontal orientation)

■ Hierarchical

You can also choose a chart format from the View menu in the Chart display 
window or right mouse click on a chart and select a chart type from the context 
menu. For more information about the buttons on the Chart Display window 
toolbar, see the Oracle Performance Manager online help.

Note: Depending upon the type of chart you are displaying, one 
or more of the chart formats may not be available.
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Setting the Chart Refresh Rate
By default, most charts are set to refresh every fifteen seconds but vary based on the 
chart.  That means that Performance Manager collects the data every fifteen seconds 
and then immediately refreshes (or redisplays) the chart using the new data.

To change the refresh rate for the current chart:

1. Click the Refresh Rate button in the Chart Display window toolbar.

Performance Manager displays the Refresh Rate dialog box.

2. Use the fields on the dialog box to set a new refresh rate for the current chart.

3. Click OK to close the dialog box and display the chart using the new refresh 
rate.

You can also choose Refresh Rate from the Collection menu to change the refresh 
rate.

Pausing and Restarting a Chart
By default, Performance Manager continues to collect performance data and update 
the current chart using the current refresh rate. 

To pause a chart so it stops redisplaying based on the refresh rate, click the Pause 
Chart button in the Chart Display toolbar.

To restart the chart, click the Resume Chart button in the Chart Display toolbar.

Selecting Chart Options
After you display a chart in the Chart Display window, you can still modify the 
collected data and data sources for the chart.  For more information about selecting 
the collected data and data sources before you display a chart, see "Selecting 
Collected Data and Data Sources" on page 3-11.

To set the chart options:

1. Click the Options button in the Chart Display toolbar.

Performance Manager displays the Options dialog box.

2. Use the Options dialog box to add or remove data items from the chart.

For more information on selecting data sources and selecting collected data, 
click Help.
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You can also access the Options dialog box by choosing Options from the Collection 
menu. 

Oracle Performance Manager also allows you to select filters to limit the data 
collected for a chart. However, not all charts provide filters. For charts that allow 
you to filter the chart data, you can select a limit to the number of data sources that 
are displayed. For example, if the data sources are the processes on an operating 
system, you can modify the chart to display only 10 processes, rather than all the 
processes. 

For example, to select a limit to the number of data sources that are displayed for 
the Pagefaults Per Session chart, do the following:

1. Highlight the Pagefaults Per Session chart in the navigator tree of the 
Performance Manager main window.

You can locate the chart by traversing the tree as follows: 
Network=>Nodes=><Name of Node>=>Process=>Pagefaults Per Process.

2. Click the Options tab in the Property Sheet panel.

3. Enter 10 in the Maximum Number of Data Sources to Display field.

The 10 data sources will be sorted by Page Faults per second, as shown in the 
Sort the data by drop-down list.

4. Click Show Chart.

Performance Manager displays the chart, but includes a maximum of 10 data 
sources.

You can later change this setting after the chart is displayed:

Note: The Pagefaults Per Session chart in the Process class is 
available only when you are monitoring a Windows NT node. For a 
UNIX node, select the Process Info chart in the Process Data class 
as an example of a chart you can filter.

Note: The number of options available on the Options tab will 
vary, depending upon the chart you are modifying. Some charts 
offer more or fewer options than the Pagefaults Per Process chart 
discussed here.
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1. In the Chart Display window for the Pagefaults Per Process chart, click the 
Options button in the toolbar.

2. In the Options tab, set the Maximum Number of Data Sources to Display back 
to 7.

3. Click OK.

These options can be useful for finding the top resource users. In the case where 
processes are the data sources and the data collected is memory usage and CPU 
usage, you can ask the Agent to limit the number of data sources to 10, and to sort 
by memory usage. Your chart would then show the 10 processes using the most 
memory. If you were to sort by CPU usage, you would get the 10 processes using 
the most CPU instead.

Some charts can also give different views of the data. If that feature is available, you 
will also be able to select a view of the data. An example of a data view may be the 
current rate per second or current rate per transaction for each piece of data 
collected in the chart.

Chart-Specific Commands
Some types of charts have their own unique commands. For example, you can select 
the Kill Session command when you are viewing the Lock Manager charts for 
Oracle database targets, or Turn SQL Trace On if you are viewing a Top Sessions 
chart. 

To see if a chart-specific command is available for a chart:

■ Click the right mouse button on an item name in the chart legend or a data item 
in the chart and click Drilldown on the context menu.

■ Click the Drilldown menu on the Chart Display window menu bar.

Drilling Down from One Chart to Another
Some charts have drill-down charts associated with them. To see if any drill-down 
charts are available for the current chart, do one of the following:

■ Click the right mouse button on an item name in the chart legend or a data item 
in the chart and click Drilldown on the context menu.

■ Click the Drilldown menu on the Chart Display window menu bar.

■ Click on the Chart Status button.
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In all cases, Performance Manager displays any drill-down charts associated with 
that chart item as menu options on the Drilldown menu. If a list of drill-down chart 
names is not displayed, no drill-down charts are associated with that item.

Using the Chart Status Button
You can use the Chart Status button located in the upper right corner of a chart to 
perform one of several tasks. When you click on the button, menu items appear 
based on the context of the chart as seen in Figure 3–2.

Figure 3–2 Chart Status Button

■ View the threshold status of chart metric(s)

The Chart Status button displays the current status of thresholds for metrics in 
the chart. If an indicator flag is present, at least one of the metrics on the chart 
has thresholds defined. The most severe threshold displays on the button. A 
green flag indicates that no metrics have crossed a threshold, a yellow flag 
indicates that at least one metric has crossed a warning threshold, and a red flag 
indicates that at least one metric has crossed a critical threshold. When you 
press the Chart Status button, you can view the status of individual metrics 
within the chart. If several metrics have crossed warning or critical thresholds, 

Note: If you have trouble selecting a particular data item when 
you try to drill down for related data, pause the chart or reduce the 
refresh rate. For more information, see "Pausing and Restarting a 
Chart" on page 3-13.
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the menu items are sorted according to the severity, with the indicators for the 
most severe items on top and the less severe on the bottom.

Thresholds are available only for node and database data.

■ Display advice on a data item

When you choose Advice from the Chart Status button, Performance Manager 
displays an information window that provides information about the currently 
selected data item along with guidelines for solving existing problems, or 
suggestions about other charts to view for further diagnosis, as seen in 
Figure 3–3.

Figure 3–3 Viewing Advice from the Chart Status Button
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■ Drill down to a chart

After you select a data item, you can choose to drill down to one of the charts 
displayed in the list or invoke tools like SQL Analyze.

■ Set or reset thresholds for a chart or an event

You can set chart-only thresholds for a data item or you can reset the chart-only 
threshold to its default value. You can choose to set or edit the threshold for the 
value in the chart only, or you can edit or register an event threshold for the 
data item. For more information, see "Registering Events in Performance 
Manager" on page 3-30.

Thresholds are available only for node and database data.

■ Edit a threshold association

You can edit a threshold association for a metric by selecting Edit Threshold 
Association from the Chart Status button and choosing an event from the dialog 
box that appears. For more information, see "Editing Threshold Associations" 
on page 3-34.

Thresholds are available only for node and database data.

■ Refresh thresholds

To view Event System changes made while a Performance Manager chart is 
visible, choose Refresh Thresholds from the Chart Status button menu on the 
Performance Manager chart. For more information, see "Refreshing Thresholds" 
on page 3-34.

Thresholds are available only for node and database data.

Drilling Down to an Historical Chart
From a Performance Manager real-time chart, you can drill down to see an 
historical view of the same data collected over a longer period of time, for example, 

Note: In addition to accessing help topics for individual metrics 
and events through the Advice function, you can view the full 
documentation set for all types of metrics and events 
independently through your web browser. For more information 
see "Viewing Metric and Event Documentation Through a Browser" 
on page 3-37.
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days, months, and years. This view of historical data, provided by the Oracle 
Capacity Planner software, allows you to analyze long-term trends in the data.

Historical data collection must be enabled to view the historical data for a chart. If 
you drill down to a historical chart for which historical data collection has not been 
enabled, Performance Manager allows you to start historical data collection. You 
can also start historical data collection by starting Oracle Capacity Planner.  From 
the Capacity Planner window, you can also control other aspects of your historical 
data collection, such as how often data is collected and loaded into the historical 
database.

To drill down to historical data:

1. Display a chart in the Chart Display window.

2. Click the right mouse button on a data item in the chart.

3. From the context menu, click Drilldown.

4. From the Drilldown submenu, click Historical Data.

What happens next depends on whether or not you have begun collecting historical 
data. Consider three possible scenarios:

■ If Performance Manager finds historical data related to the chart, Performance 
Manager displays the Analysis Chart window.

Note that if you previously set up your historical database using an alternate 
database location, Performance Manager displays a database logon box before it 
displays the Analysis Chart window.

The Analysis Chart window shows you the historical information about the 
collected data. From here, you can modify the format of the chart or perform a 
trend analysis on the historical data. For more information, select an option 
from the Help menu in the Analysis Chart window or see the chapter about 
Capacity Planner in this manual.

■ If Performance Manager cannot find historical data related to the chart, the 
following message appears:

The historical chart cannot be displayed because there is no history 
available for the data sources or data items.

Note: User-Defined charts do not support drill-down to historical 
data.
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Would you like to begin collecting the history of these data sources and 
data items now so that you can view the chart in the future?

Click Yes to begin collecting historical data automatically or click Help to learn 
how to collect historical data using the Oracle Capacity Planner software.

When you click Yes, Performance Manager displays another message 
explaining that historical data is now being gathered, but is not yet available.  
Click Continue to return to the Display Chart window.

■ If no historical data has ever been saved to the historical database, Performance 
Manager displays a message box that includes the following errors:

Error connecting to the historical database.
The specified schema is not a Capacity Planner database.

Click Continue. Performance Manager displays the message described in the 
previous bullet item. 

Click Yes to begin collecting historical data or click Help for more information 
about how historical data is collected. When you click Yes, Performance 
Manager displays another message explaining that historical data is now being 
gathered, but is not yet available.  

Click Continue to return to the Display Chart window.

Displaying Alternate Chart Orientations
You can display bar charts and tables with either a horizontal or vertical orientation.

To change the orientation of the bar chart or table, click the button associated with 
the orientation that you want.

Sorting Data in a Table Chart
When a chart is displaying data in table format, the sort order of the column data 
can be changed by clicking the column headers in the table. The first click on a 
column header sorts the data in ascending order, and a second click sorts the data in 
descending order.

Changing the sort order in the chart table does not affect the data’s sort order on the 
server. To change the sort order of the data on the server, use the Options page. For 
more information, see "Selecting Chart Options" on page 3-13.
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Saving Your Changes to a Chart
If you are working in repository mode and you make modifications to a chart (for 
example, if you change the format, orientation, or sorting order of a chart), you can 
save your changes in one of two ways:

■ Click Save on the Chart Display File menu.

Performance Manager saves your changes using the same name as the original 
chart. When you display the chart again, your changes will appear in the Chart 
Display window.

To later remove your changes and display the predefined chart using its 
original settings, click Remove Chart on the Chart menu.

■ Click Save As on the Chart Display File menu.

Performance Manager displays the Save Custom Chart dialog box. Use this 
dialog box to enter a name for the custom chart and to indicate whether you 
want to create a similar chart for other targets of the same type.  For 
information about the fields on the Save Custom Chart dialog box, click Help.

Click OK in the Save Custom Chart dialog box to save the custom chart using 
the name you provided.  Performance Manager saves the chart in the Custom 
Charts folder for the selected target.

To delete a custom chart from the Custom Charts folder, select the chart and 
click Remove Chart on the Chart menu.

Obtaining Help for a Class, Chart, or Data Item
To get help on a class or chart:

1. Select the class or chart in the main window navigator.

2. From the Help menu,  choose Selected Item.

Note: You can remove the changes you saved to a predefined 
chart, but you cannot delete the original predefined chart.

Note: You can delete custom charts, but you cannot delete 
predefined charts.
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If help is available for the selected chart, Performance Manager displays a 
message box or a help topic window describing the chart data.

To get help on a data item:

1. Select a chart.

2. In the Property Sheet panel, select a data item and choose Selected Item from 
the Help menu.

Printing a Chart
To print a chart, click the Print Screen button on the Display Chart window toolbar.

The size of the chart on the screen determines the size of the chart in the chart 
printout. For example, when you print a chart that is 5 inches high and 7 inches 
wide on your screen, the chart will be 5 inches high and 7 inches wide in the 
printout.

Generating a Report for a Chart
To generate an HTML report for a chart:

1. Click the Report Chart button while the chart is displayed.

Performance Manager displays a dialog box that tells you the name of the 
HTML file used to display the report and where the file will be saved. 

2. Make a note of the file name and location.

3. Click Yes to preview the chart in your Web browser, or click No if you do not 
want to preview the report.

You can view the report later using a Web browser, or—if you have experience with 
Web publishing tools and techniques—you can share the report with your 
co-workers by publishing the HTML file and its associated graphic files on a Web 
server. 

Recording Chart Data
Oracle Performance Manager allows you to record the data being monitored in a 
chart. After a recording is complete, you can play it back. During playback, you can 
pause and fast forward the recording, if you wish.

Note: Help is not available for all objects.
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Chart recordings are saved under the Recordings folder and on the Recordings tab 
of the right pane of the Performance Manager main window when a recorded chart 
is selected. The Recordings tab is added to a chart’s property sheet after you record 
the chart.

You can manage chart recordings in the Recordings folder without connecting to 
the target from which a chart was recorded. If you are already connected to a target, 
you can see a chart’s recordings by selecting the Recordings tab in that chart’s 
Detail property sheet.

Starting a Recording
You start a recording by performing one of the following steps:

■ With a chart highlighted in the navigator tree of the Performance Manager main 
window, click Record Chart on the chart’s property sheet.

■ With a chart displayed in the Chart Display window, click Start Recording in 
the Chart Display window toolbar.

■ With a chart displayed in the Chart Display window, click 
File=>Recording=>Start Recording.

Oracle Performance Manager displays the Recording Parameters dialog box.  For 
more information on the fields in the Recording Parameters dialog box, click Help.

Stopping a Recording
To stop recording a chart, do one of the following:

■ To stop recording the current chart, click the Stop Recording button in the 
Chart Display window toolbar.

■ To stop all recordings at one time, choose Stop All Recordings from the 
Performance Manager main window Recordings menu.

■ To stop a recording from the Recordings folder, expand the Recordings folder 
in the Performance Manager main window and navigate to the chart.  Select the 
chart and click Stop Recording on the chart’s property sheet.

■ With a chart displayed in the Chart Display window, click 
File=>Recording=>Stop Recording.
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Playing a Recording

To play a recording, do the following in the Performance Manager main window:

1. Navigate to the Recordings folder.

2. Select the chart you want to play in the navigator tree.

3. In the corresponding property sheet, select the recording from the list of 
recordings for the selected chart, and click Play Recording (or on the 
Recordings menu click Play Recording).

4. In the Chart Display window toolbar, click Start Playback.

The Stop Playback, Pause Playback, and Fast Forward buttons become 
available in the playback window (Figure 3–4).  When the playback is complete, 
the Reset Playback button becomes available.

Figure 3–4 Chart Playback Buttons in the Chart Display Window

Removing a Recording
To remove a recording:

1. Navigate to the Recordings folder or the Recordings tab on the chart’s Detail 
page.

2. Select the recording you want to remove.

3. From the Recordings menu, click Remove Recording.

Stopping an ABAP/4 Program
From the Work Process Overview chart, you can stop an ABAP/4 program running 
on an SAP R/3 work process. To do so:

Note: Before you can play a recording, you must stop the 
recording.  For more information, see "Stopping a Recording" on 
page 3-23.
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1. Display the Work Process Overview chart.

2. Select a work process on which an ABAP/4 program is running.

3. Click the right mouse button.

4. On the context menu, choose Exit ABAP/4 Program from the Drilldown menu.

Restarting an SAP R/3 Work Process
From the Work Process Overview chart, you can terminate an SAP R/3 operating 
system work process and start up a new work process. To do so:

1. Display the Work Process Overview chart.

2. Select the work process that you want to terminate.

3. Click the right mouse button.

4. On the context menu, choose  Restart Work Process from the Drilldown menu.

The Restart Work Process option terminates the operating system work process and 
starts a new work process. Because it is a different work process, the new work 
process has a different PID than the terminated work process.

Chart Display Window Menu Shortcut Keys
Table 3–2 lists the Chart Display Window menu and submenu items along with 
their corresponding shortcut keys.

Table 3–2 Chart Display Window Shortcut Keys 

Task Shortcut Key

Print Screen . . . Control+P

Report Chart. . . Control+R

Start Recording Control+K

Stop Recording Control+J

Start Playback Control+Q

Stop Playback Control+Y

Pause Playback Control+W

Fast Forward Control+F
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Working With Events and Thresholds in Performance Manager
You can create and edit threshold values from both the Oracle Enterprise Manager 
console and Performance Manager.

From Performance Manager, you can create and edit a Chart-only threshold, create 
and register an event, reset a Chart-only threshold, or edit a registered event. From 
the Enterprise Manager console, you can create, edit or deregister an Enterprise 
Manager event but you cannot edit or view Chart-only thresholds.

You can set thresholds on data items by using event tests or by setting a threshold 
for a data item in a chart (Chart-only threshold) using the Set Chart-only Threshold 
dialog box seen in Figure 3–5. When you monitor a chart that contains a data item 

Reset Playback Control+B

Save Control+S

Save As Control+A

Close Alt+F4

Pause/Resume Chart Control+Q

Refresh Rate . . . Control+E

Options Control+O

Historical Data Control+D

Using Help Control+Shift+U

Help on Item Control+Shift+H

Contents Control+H

Search . . . Control+Shift+S

Window F1

Note: The Performance Manager threshold and event features 
described in this section are available only for node and database 
data.

Table 3–2 Chart Display Window Shortcut Keys (Cont.)

Task Shortcut Key
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that supports a threshold established for an event, you can edit the parameters for 
that event by choosing Set Threshold from the Chart Status button.

When you create events from Performance Manager, the event is initialized with 
the context defined by the Performance Manager chart. You can only modify the 
event tests in an event if the event was registered using the Oracle 9i Agent.

If a data item supports the concept of an event, the chart displays a visible indicator 
(a flag) based on thresholds stored in the repository for that data item. If the data 
item does not support the concept of an event, you cannot establish a chart-only 
threshold for the data item. Every metric-based event test can have a warning and a 
critical threshold value. The flag indicators on a chart specify whether a threshold 
value has crossed a warning or critical threshold. The flag that appears on the Chart 
Status button in a chart displays the most serious state of any contained metric 
thresholds, and the metrics that appear when you click on the Chart Status button 
are sorted with the most serious indicators displayed first in the list.

Figure 3–5 Set Chart-only Threshold dialog box

Threshold values may be derived from one of three sources:

■ A default value for some metrics that is added to the repository at the time of 
product installation.
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■ Chart-only thresholds, which are warning and critical threshold values for a 
specific metric, target, target type and instance.

■ An event test derived threshold, which can be shared among administrators 
depending on the access rights of the user and the event containing the event 
test. When you set a threshold on a data item associated with an existing event, 
the thresholds displayed in that chart correspond to the thresholds set for the 
event test.

The threshold types listed above apply to metrics in a specific order of precedence:

■ If you have Event System access and access to an event containing a metric, the 
threshold values for the metric are defined by the Event Test and override any 
Chart-only or default threshold values.

■ If you have established a Chart-only threshold for a metric, the threshold values 
you establish are valid and supersede any default values that may exist.

■ If neither of the previous two scenarios exist and a default threshold is defined 
in the repository for the metric, the default value defines the warning and 
critical thresholds for this metric, regardless of target or data source.

Threshold values are stored in the Oracle Management Server respository and are 
updated whenever the user sets or edits a Chart-only threshold or when Event 
registration changes occur. Chart-only thresholds are removed from the repository 
when you invoke Reset Threshold or when the Administrator is removed from the 
system. If you create a Chart-only threshold that is later overridden by the 
registration of an event, the Chart-only threshold remains in the repository. If the 
association between the metric and the event is later broken, the Chart-only 
threshold is restored.

To set or edit thresholds in Performance Manger:

1. Click the Chart Status button in the upper right corner of the chart below the 
menu bar.

2. Select the data item for which you want to set a threshold and then choose Set 
Thresholds from the context menu.

If there is more than one data source displayed in a chart when you select Set 
Thresholds, Performance Manager displays the Select Data Source dialog box 
where you must choose a single data source for which to set a threshold. When 
you create or edit a chart-only threshold or create a new event, you must choose 
a single data source before setting thresholds.

3. To set or modify a Chart-Only threshold, select Set Chart-Only Threshold at 
the bottom of the window. To register an event, select Register Event.
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4. To set or modify a Chart-Only threshold, add or modify the values in the 
Warning Threshold and Critical Threshold fields. If default warning or critical 
threshold values are defined for the metric, the input fields will contain these 
values.

To register or modify an event, select Register Event and then complete the 
fields in the General, Test, Parameters, Schedule, Access and Fixit Jobs pages of 
the event property sheet. If you are using a pre-9i Agent and you modify an 
event that has been registered, those changes are not used by the registered 
event.

Triggered Events and Thresholds
Events and thresholds often poll at different intervals. For example, events may be 
polled at intervals of minutes or even hours, while thresholds may be sampled in 
seconds. The result is that you could see a metric cross a threshold in a chart but not 
be notified of an event simultaneously. If the problem were caused by a spike, the 
threshold may be crossed in the chart with a sampling occurrence measured in 
seconds, but not trigger an event because the metric is sampled in minutes or hours, 
meaning the event is never triggered at all.

Additionally, events can include the concept of occurrences. Occurrences prevent 
notification for erratic or one-time instances of a threshold being crossed. If an event 
has a number of occurrences associated with a test, you may see the threshold 
crossed in a chart but never see the corresponding event triggered.

Events Registered for Multiple Targets
If you attempt to modify a threshold that has an associated event test registered for 
multiple targets, a warning displays indicating that the change you make will affect 
the event test for multiple targets and that if you want to use different thresholds 
for each target, you must create separate events. If you continue with the change, 
the existing event is deregistered for all targets and re-registered for all targets with 
the new threshold.

Note: If you do  not have permission to access the Enterprise 
Manager Event System, the option of registering an event from the 
dialog box is not present.
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Metrics with Multiple Events and Different Thresholds
When you display a chart for a data item for which there are multiple event tests, a 
message is displayed indicating that there are multiple tests for the same metric. To 
show a threshold for the chart, you must select which event test to associate with 
the metric. If you then modify the associated event test or the metric in the chart, 
the thresholds are synchronized. Other tests of the metric are not affected by 
changes to the threshold in a chart.

If another user de-registers the associated event test and then you display a chart 
with that metric, a warning displays indicating that the previously associated event 
test no longer exists. If only a single event test remains for the metric, the message 
indicates that the remaining event is now associated with the metric. If more than 
one event remains, the message indicates that you must select a new event to 
associate with the metric.

If you add a new event test for a metric where a single chart-only threshold already 
exists, the thresholds associated with the previous test will not be used during 
monitoring.

Event Permissions
If you display a chart for which you have read-only permission for the 
corresponding event, you cannot modify the thresholds for that chart. You receive a 
read-only view of the event indicating that if you wish to change the thresholds 
associated with the data item, you must be granted appropriate access to the event 
system.

Registering Events in Performance Manager
You can register events from within Performance Manager through the Chart Status 
button on a chart containing the data item for which you want to register an event. 

Registering events through Performance Manager is procedurally identical to 
registering events through the Enterprise Manager console.

To create or edit events in Performance Manager:

1. Click on the Chart Status button in the upper right corner of the chart.

Note: Super-users  who set up permissions on an event should 
consider the effect on non-privileged administrators who will be 
unable to modify the thresholds.
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2. Select the data item and then choose Set Threshold from the context menu.

If there is more than one data source displayed in a chart when you select Set 
Threshold, Performance Manager displays the Select Data Source dialog box 
where you must choose a single data source for which to set a threshold. When 
you create or edit a Chart-only threshold or create a new event, you must 
choose a single data source before setting thresholds.

3. Select Register Event at the bottom of the dialog box.

4. Complete or modify the fields in the General, Test, Parameters, and Permissions 
pages of the property sheet to create a new event. If you are using a pre-9i 
Agent and you modify an event that has been registered, those changes are not 
used by the registered event.

When you use a pre-9i Agent, the property sheet for creating a new event is similar 
to the property sheet for modifying an event. Some fields are editable while others 
are not. If you are using a 9i Agent, you can modify many more fields.

You can use several predefined event tests that have been installed with Oracle 
Enterprise Manager. See Chapter 5, "Introduction to SAP Event Tests" for more 
information on these event tests.

About Oracle 9i and Pre-9i Agents
If you attempt to register a 9i event with a pre-9i Agent, you will receive an error 
message indicating that you cannot register the event. You can use only a 9i Agent 
to register 9i events. 

If there exists both a 9i and pre-9i version of the same event, then the Oracle 
Management Server will determine which to use depending on the Agent version. 
For example, if there is a 9i Agent, the Agent will request registration using the 9i 
version of the event. If the Agent is pre-9i, then it will use the pre-9i version.

If you have migrated from a pre-9i Agent, then an existing event will not 
automatically use the 9i counterpart. To use the 9i test and access thresholds in the 
repository, you must deregister the pre-9i event and register the 9i event using the 
9i Agent.

Viewing Thresholds
If a Performance Manager chart is displaying metrics that have multiple data 
sources, you can display the View Thresholds dialog box to view all threshold 
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indicators. The View Thresholds dialog box is accessible from the Chart Status 
button.

The View Thresholds dialog box displays the current threshold status of each data 
item and its corresponding data source. You can view the status for each 
metric/data source pair using flags to indicate whether the value of the data item 
has passed its warning or critical threshold. If a data item has no threshold set, the 
column containing that data item is left blank.

When you display the View Thresholds dialog box, the current data item and 
threshold values are captured in a dataset and the status of each threshold is 
displayed in the table. A timestamp of the dataset appears in the bottom left corner 
of the View Thresholds dialog box.

If you change a threshold value for a data item while the View Thresholds dialog 
box remains open, the new threshold value is compared against the dataset created 
at the time you displayed the dialog box, not against the current value of the data 
item in real time. To refresh the statuses in the View Threshold dialog box, close and 
redisplay it.

You can add or change threshold values by clicking the Chart Status button on the 
View Thresholds dialog box and choosing Set Threshold from the context menu.

To view thresholds:

1. Click the Chart Status button for the chart containing the data item for which 
you want information and select View thresholds from the context menu.

The View Thresholds dialog box appears, displaying the status of any 
thresholds set for each of the data items and data sources in the chart. The 
status for a threshold is indicated by the flag that appears in the column for the 
data item and data source.

■ A green flag indicates the value for the data item has not crossed a  
threshold.

■ A yellow flag indicates the value for the data item is at or has passed the 
warning threshold.

■ A red flag indicates the value for the data item is at or has passed the 
critical threshold.

If no threshold is set for a data item, the status for that metric is left blank.

The threshold statuses that appear in the View Thresholds dialog box are 
derived from dataset values gathered at the time you display the View 
Thresholds dialog box. The date and time of the dataset appears at the bottom 
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of the dialog box. The View Thresholds dialog box is not updated when the 
Performance Manager chart is refreshed.

From the View Thresholds dialog box, you can set thresholds or reset and edit 
associations for a specific cell if thresholds are set.

You can set or edit a threshold for a metric from the View Thresholds dialog box by 
clicking the Chart Status button and selecting Set Thresholds from the context 
menu. For more information about setting thresholds, see "Working With Events 
and Thresholds in Performance Manager" on page 3-26.

Resetting Thresholds
You can reset Chart-only thresholds through the Chart Status button on a chart. If 
you reset a Chart-only threshold for a data item, the current threshold is deleted 
and is reset to its default value. If the data item has no default value, the threshold 
is simply deleted and no value is assigned as a threshold.

If you select Reset Threshold for a data item with an assigned event, a message box 
displays stating that you must deregister or edit the event from within the 
Enterprise Manager console.

To reset a threshold:

1. From the chart, click on the Chart Status button and select the metric and data 
source for which you want to reset a threshold.

2. From the context menu, choose Reset Threshold. When you select Reset 
Threshold, the current data item is reset to its default value. If the data item has 
no default threshold value, the threshold is eliminated.

A confirmation dialog box appears, verifying that you are about to reset the 
threshold for the current metric. Click the OK button to confirm.

If no threshold exists for the metric, an error dialog box displays informing you 
that the threshold cannot be reset because no threshold exists for the metric.

Note: If you add or change the value of a threshold for a data 
item, the status flag for the data item on the currently displayed 
View Thresholds dialog box is updated based on the values stored 
in the dataset at the time the View Thresholds dialog box was 
displayed. To update all the status flags in the current chart, close 
the View Thresholds dialog box and redisplay it.
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If you attempt to reset a threshold associated with a registered event, an error 
message dialog box displays. You cannot deregister an event from within 
Performance Manager because the event associated with a metric may have several 
other targets and tests. You can instead edit the event from within Performance 
Manager by choosing Set Threshold (for 9i targets) to remove or modify the event.

Refreshing Thresholds
A chart may not reflect an event that is registered while the related chart is open 
because the information for the metric in the chart related to the event has not been 
read from the repository. A chart does not automatically reflect the effect of event 
system changes. When you select Refresh Thresholds from the Chart Status button, 
Performance Manager updates the chart with the new data from the threshold 
repository and updates the chart threshold indicators.

When Event Registration or Permission changes effect the threshold respository, 
Performance Manager users are notified of these changes in a dialog box when the 
threshold data for the metric is next read from the repository. The following actions 
are conveyed to the Performance Manager user when a chart is opened, thresholds 
are refreshed for a chart, or thresholds are edited:

■ An event test associated with a metric has been deregistered.

■ A Chart-only threshold is overridden by the registration of an event test by 
another user.

■ An event test associated with a metric has failed registration.

■ Access to an event containing an event test associated with a metric has been 
removed.

■ An event test associated with an event has been removed from the event or the 
instance has been modified.

■ An event test associated with a metric has failed event modification.

To refresh thresholds, choose Refresh Thresholds from the Chart Status button on 
the Performance Manager chart.

Editing Threshold Associations
There may be circumstances when a user has permission to view several events that 
contain the same event test. When viewing a chart, you must decide which event 
will be associated with the metric in the chart. You can invoke Edit Threshold 
Association to change this association.
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The Edit Threshold Association menu item has no application for data items with 
less than two events assigned to it. If you select Edit Threshold Association in such 
a case, a message box appears informing you that the threshold association cannot 
be changed because a threshold association for the metric does not exist or there is 
only one registered event test.

You cannot change the association for Chart-only thresholds because each user has 
his own pool of Chart-only thresholds and duplicates are not supported.

To edit threshold associations:

1. Click the Chart Status button in the current chart and select the metric for which 
you want to edit the threshold association, and then choose Edit Threshold 
Association from the context menu.

2. When applicable, select the data source from the Select Data Source dialog box 
and click OK.

3. Select the event threshold you want to assign to the data item in the list that 
appears in the Associate Metric with Event Test dialog box.

4. Click the OK button at the bottom of the Associate Metric with Event Test 
dialog box.

To edit threshold associations:

1. Click the Chart Status button in the current chart and select the metric for 
which you want to edit the threshold association and then choose Edit 
Threshold Association from the context menu.

2. When applicable, select the data source from the Select Data Source dialog box 
and click OK.

3. Select the event threshold you want to assign to the data item in the list that 
appears in the Associate Metric with Event Test dialog box.

4. Click on the OK button at the bottom of the Associate Metric with Event Test 
dialog box.

Note: If you attempt to set a threshold association when the 
metric is not associated with an event test or you only have 
permission to view one registered event test for the specified target 
and data source, an error dialog box appears informing you that the 
association cannot be changed.
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Running Performance Manager in a Browser
You can run Oracle Performance Manager in a browser and use a significant subset 
of the features of the full product, including basic monitoring features and event 
integration. Browser support includes basic monitoring features and event 
integration if you are using a version 9i Agent (or later).

The following features are available when running Performance Manager in a 
browser:

■ Show database chart

■ Show node chart

■ Drilldowns

■ Help

■ Quick Tour

■ Pause/Resume charts

■ Set Refresh Rate

■ Set Options

■ Setting Chart-only thresholds (this feature is available for node and database 
data only)   

■ Event Registration (this feature is available for node and database data only) 

The following features are not available while running Performance Manager in a 
browser:

■ Recordings

■ Historical collection drilldowns

■ Custom Charts

■ Saved chart attributes

■ User-defined charts

■ Print Screen from charts

■ Report Chart from charts

■ Direct Connect

■ Standalone mode
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■ SQL Analyze

■ Threshold status

Viewing Metric and Event Documentation Through a Browser
You can view specific information about metrics, events, charts and classes in 
Performance Manager through the Advice function on the Chart Status button and 
through other contextual functions within the Oracle Enterprise Manager 
application. However, you can view the full set of documentation for all the 
following types of metrics and events independently through your web browser 
without having to access the Oracle Enterprise Manager application. The 
documentation available through your browser provides a comprehensive Table of 
Contents, an index keyword search, and a full text search function.

■ Oracle Database

■ Windows NT

■ IBM AIX

■ Sun Solaris

■ HP-UX

■ Compaq Tru64

■ SAP R/3 System

■ Oracle Applications system

For each of these types of metrics and events, the following information is 
provided.

For Metrics:

■ Classes

■ Charts

■ Data Items

■ Description

■ Source

■ User Action

■ Event Tests
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■ Description

■ Source

■ Parameters

■ Output

■ Frequency

■ User Action

To access each documentation set, open the appropriate file below in a web 
browser:

■ Oracle Database -- ORACLE_HOME/doc/EM/Webhelp/dba/dba.htm

■ Windows NT -- ORACLE_HOME/doc/EM/Webhelp/nt_os/NT_OS.htm

■ IBM AIX -- ORACLE_HOME/doc/EM/Webhelp/aix/AIX.htm

■ Sun Solaris -- ORACLE_HOME/doc/EM/Webhelp/sol/SOL.htm

■ HP-UX -- ORACLE_HOME/doc/EM/Webhelp/hpux/HPUX.htm

■ Compaq Tru64 -- ORACLE_HOME/doc/EM/Webhelp/dec/DEC.htm

■ SAP R/3 -- ORACLE_HOME/doc/EM/Webhelp/sap/sap.htm

■ Oracle Applications System -- ORACLE_
HOME/doc/EM/Webhelp/oafnd/OAFND.htm
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Introduction to Oracle Capacity Planner

Oracle Capacity Planner is an Oracle Enterprise Manager application that allows 
you to collect different types of performance statistics and record that data in an 
historical database.  You can then use Oracle Capacity Planner to analyze the 
historical data to plan future capacity.

Oracle Capacity Planner uses the Intelligent Agent (Agent) to collect its historical 
data. To collect most types of data, you must install the Agent on the system (or 
systems) where you want to collect data. To collect data from an SAP R/3 target, the 
Agent on the NT proxy machine for the target is used. See "Configuring the NT 
Proxy Machine to Manage SAP R/3 Data" on page 2-5 for information on 
configuring the NT proxy machine to collect SAP data on a SAP target.

If you are using Oracle Capacity Planner to collect database data, the Agent can be 
installed on another system (note that you must have the Oracle Diagnostics Pack to 
monitor database data).   

Note: In releases prior to 9i, the Agent data gathering service (also 
known as the Oracle Data Gatherer) was used to collect data for 
presentation in real-time performance monitoring utilities and 
historical data. The Intelligent Agent and the data gathering service 
were separate services that were started and stopped 
independently of each other.

With 9i, the data collection capabilities are integrated into the 9i 
Intelligent Agent. Therefore, there is no separate service that needs 
to be started. Furthermore, when you stop the 9i Intelligent Agent, 
the data gathering capabilities are disabled and not available.
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The types of performance data that Oracle Capacity Planner can collect on a system 
depend on the products that are installed. Table 4–1 shows the types of data that 
Oracle Capacity Planner can collect when various Oracle products are installed. 

If additional products from Oracle or other vendors are installed, Oracle Capacity 
Planner may be able to collect additional types of data not shown in Table 4–1.

How Capacity Planner Collects and Stores Performance Data
The following list identifies how Capacity Planner uses the Agent to collect 
performance data:

■ The Agent collects the data at an interval you specify from within Capacity 
Planner.

The Agent stores the data in an efficient binary form.

■ At a specified loader interval, the data is read from this binary file and stored in 
a readable form in the Oracle Capacity Planner historical database.  

The Agent also aggregates the data by time, creating summary statistics for the 
data that is collected at different time intervals (hour, day, week, and so on). 

■ Over time, the Agent purges the data in the historical database, keeping only as 
much data as you specify.  

Table 4–1 Data That Capacity Planner Can Collect When Various Oracle Products are 
Installed 

Oracle 
Product

Oracle 
Concurrent 
Manager 
Data

Oracle 
Database 
Data

Node 
(Operating 
System) 
Data

SAP R/3 
System 
Data

Microsoft 
SQL 
Server 
Data

Diagnostics 
Pack

No Yes Yes No Yes

Management 
Pack for 
Oracle 
Applications

Yes No Yes No No

Management 
Pack for SAP 
R/3

No No Yes Yes No
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Purging the historical data allows you to have access to a current view of recent 
performance data for your environment and to manage the amount of stored 
data to avoid wasting disk space.

Usage Scenarios for Oracle Capacity Planner
Oracle Capacity Planner can perform tasks such as the following:

■ Track the increase in the amount of used space on a disk over time and estimate 
when 95 percent of the space on the disk will be consumed

■ Track the increase in the total I/O rate for a host over time, then estimate what 
the total I/O rate for the host will be at some future point in time

■ Determine thresholds to set in Performance Manager by evaluating historical 
data gathered in Capacity Planner

■ Provide a predefined set of data that measures performance (Oracle 
Recommended Collection)

■ Publish historical data to a website where administrators and system 
administrators can view data that is periodically updated

Starting Oracle Capacity Planner
You can start Oracle Capacity Planner in any of the following ways:

■ On the Oracle Enterprise Manager console, click the SAP R/3 Management 
drawer, then click the Capacity Planner icon.

■ On the Oracle Enterprise Manager console, select an SAP R/3 System  target, 
click the right mouse button, point at Related Tools in the context menu, then 
click Capacity Planner.

■ On the Tools menu of the Oracle Enterprise Manager console, point to SAP R/3 
Management, then click Oracle Capacity Planner.

■ From the UNIX command line, change directory to the ORACLE_HOME/bin 
directory (where  ORACLE_HOME represents the home directory in which the 
Oracle Management Pack for SAP R/3 is installed), then type the following 
command:

./oemapp cp
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■ From the Start menu, point to Programs, then to the Oracle Home where Oracle 
Enterprise Manager is installed, then to Management Pack for SAP R/3, then 
click Capacity Planner, which displays the Capacity Planner Login dialog box.

Enter the appropriate connect information for your Oracle Enterprise Manager 
repository, then click OK.

Using Help
When you are using Oracle Capacity Planner, you can display context-sensitive 
help topics. You can also display conceptual topics and task topics.

To obtain context-sensitive help for an Oracle Capacity Planner panel, window, 
dialog box, or property page, select an item in the panel, window, dialog box, or 
property page, then on the Help menu, choose Window.

To obtain context-sensitive help for a class, chart, or data item on a property page, 
select the class, chart, or data item on the property page, then take one of the 
following actions:

■ Press F1.

■ Click the Help icon on the toolbar.

■ On the Help menu, choose Selected Item.

If a help topic is not available for a class, chart, or data item, a No Help Available 
message is displayed when you request help.

To view the Contents page for the Oracle Capacity Planner help, on the Help menu, 
choose Contents. On the Contents page, you can:

■ View a list of the conceptual help topics by double-clicking the Conceptual 
Topics book on the help system’s Contents page.

Conceptual topics provide conceptual or overview information of which you 
should be aware before performing a particular Oracle Capacity Planner task. 
Conceptual topics do not contain step-by-step information for performing a 
task.

■ View a list of the task help topics by double-clicking the Task Topics book on 
the help system’s Contents page.

Task topics provide step-by-step instructions for accomplishing an Oracle 
Capacity Planner task. They do not provide conceptual information that you 
should be aware of before performing the task.
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You can access a glossary of Oracle Capacity Planner terms by double-clicking the 
Oracle Capacity Planner Glossary book on the Contents page.

Using Oracle Capacity Planner
You may find it helpful to think of using Oracle Capacity Planner as a two-step 
process:

1. Setting up the collection of historical data

See "Setting Up a Collection" on page 4-5 for a detailed description of how to 
collect historical data.

2. Analyzing the collected data

See "Analyzing Collected Data" on page 4-19 for a detailed description of how 
to analyze collected data.

Setting Up a Collection
To set up a historical data collection with Oracle Capacity Planner, you:

1. Select (and connect to) the targets for which you want to collect historical data.

2. Define the frequency of collection samples.

3. Define the location of the historical database and the frequency at which 
collected data should be loaded in the historical database.

4. Define the amount of data to be kept in the Oracle Capacity Planner database at 
each time interval.

5. Select the classes of data to collect, based on what is available in the Oracle 
Capacity Planner navigator.

Figure 4–1 shows the steps to follow when setting up a collection.  For more 
information on each step, see the following sections.
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Figure 4–1 Steps for Setting Up a Collection

Selecting Targets
You can select one or more targets from which you want to collect historical 
performance statistics. For example, when you have the Oracle Management Pack 
for SAP R/3 installed, the target types can include Nodes and SAP R/3 Systems. 

The procedure for selecting a target depends upon whether or not the server resides 
on a node that is known to the Enterprise Manager main console.  A node is known 
to the console when it has been discovered with the Enterprise Manager console 
Discover Nodes command.

Selecting Targets on Discovered Nodes
To select a target on a node that has been discovered by the Enterprise Manager 
console:

1. Click the Collection tab of the Oracle Capacity Planner navigator panel, which 
displays the Oracle Capacity Planner collection view. 

2. Double-click one of the target type folders.

The Oracle Capacity Planner navigator tree displays the targets of the selected 
type that are known to the Oracle Enterprise Manager main console.

3. Select the target from which you want to collect performance data and click the 
Connect button in the Capacity Planner toolbar, or click the plus sign (+) next to 
the target in the navigator.

Define the collection frequency

Define the frequency of loading class data

Define the amount of data to keep 
for a time interval

Select a service to collect data from

Specify the classes to collect

NU-3695A-AI
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When you connect to a target in the Oracle Capacity Planner navigator panel, 
you may be prompted for credentials if they are required to connect to that 
target. If a logon dialog box appears, click Help for information on the 
individual fields on the dialog box. 

After you connect to a target, the available collection classes for that target 
appear in the navigator and Oracle Capacity Planner displays the Target 
property sheet for the selected target.  For example, Figure 4–2 shows the 
classes that appear when you connect to a Windows NT node target.

Figure 4–2 Selecting a Target in the Oracle Capacity Planner Window

Selecting Targets on Undiscovered Nodes 
If you double-click a target type and the target you are looking for does not appear 
in the target type folder, you can do one of the following:

■ Use the Enterprise Manager console to discover the node where the target 
resides.

This is the preferred method for adding a target to the Capacity Planner 
navigator panel.  When you discover a node with the Enterprise Manager 
console, Capacity Planner saves key information about the target, such as the 
preferred credentials, location of the Agent, and historical database 
information.
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To discover an SAP R/3 target in the Enterprise Manager console, you need to 
discover the NT proxy machine for that SAP target.

■ Add the target manually to the Capacity Planner navigator panel.

When you add a target manually, the target is added for the current session of 
Capacity Planner only. You can start gathering data for the target, but the next 
time you start Capacity Planner, the target will not appear in the navigator 
panel. To modify collection settings or analyze data collected for the target, you 
will have to add the target again the next time you start Capacity Planner.

To add a target manually:

1. Select the target type for the target you want to add.

2. Click the Add Service button in the Capacity Planner toolbar.

Capacity Planner displays a message to remind you that targets you add 
manually will be available for the current session of Capacity Planner only.

3. Click Yes.

Capacity Planner displays a logon dialog box for the target. Click Help if you 
need information about any of the specific fields on the dialog box.

4. After you fill in the logon credentials, click OK to connect to the target.

After you connect to a target, the available collection classes for that target 
appear in the navigator and Oracle Capacity Planner displays the Target 
property sheet for the selected target (Figure 4–2). 

About the Target Property Sheet
When you connect to a target, Oracle Capacity Planner displays the Target property 
sheet, which contains the following property pages:

■ Collection Options page

■ Storage Options page

■ Purge Options page

The collection, load, and purge settings you select on these pages apply to all the 
classes in the selected target.  You cannot change these settings for a selected class; 
you can change them only for a selected target.
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Defining the Frequency of Collection Samples
When you first connect to a target, Capacity Planner displays the Collection 
Options property page.  The values you select on this page determine how often the 
Agent will collect information about the selected target and save it to disk.   On the 
Collection Options property page, you can set the frequency of collection samples 
using either of these two methods:

■ By selecting the number of data samples to collect for a specified time interval

For example, to collect information 3 times every hour, select Samples per Time 
Interval, enter 3 in the text field, and choose Hours from the drop-down list.

■ By specifying the length of time between collection samples

For example, to collect information every 20 minutes,  select Time Between 
Samples, enter 20 in the text field, and choose Minutes from the drop-down 
list.

Defining the Location of the Historical Database
After you set the frequency of collection samples, use the Storage Options tab to 
specify the location of the Oracle Capacity Planner historical database. This setting 
defines where Capacity Planner will save information collected for the selected 
target. When data is saved in the historical database, you can later analyze the data 
or use it to generate trend analyses.

Note: To configure the settings for collecting data, the Agent that 
will collect data for a target must be running.  Normally, the Agent 
is located on the host where the target is located. For SAP targets, 
the Agent on the NT proxy machine is used.
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By default, collected data is saved in your Oracle Enterprise Manager repository. 
However, you can specify an alternate database for the historical data if you do not 
want to store historical data for the selected target in the repository.

To save the data collected for a target in a location other than the Oracle Enterprise 
Manager repository:

1. From the Storage Options tab, select Store historical data in alternate location.

2. Enter the credentials for the database that will store the collection data for the 
target.

Enter the appropriate user name, password, and target for the Oracle Capacity 
Planner historical database.  This connection information is used by the Agent 
when it loads the collected data at the specified loader interval.  Therefore, the 
target specified for the Oracle Capacity Planner historical database must be 
known and accessible from the host where the Agent is running.  

For example, if you specify MY_DB.WORLD as the historical database and your 
Agent is running on host MYNODE, then database MY_DB.WORLD must be 
reachable via Net8 or SQL*Net from host MYNODE (MY_DB.WORLD must 
exist in the TNSNAMES.ORA file for host MYNODE, for example).

Defining the Frequency of Loading Collection Data
After you define how often data will be collected and where the data will be stored, 
you can define how often the data will be loaded into the historical database.

You can determine how frequently the Oracle Capacity Planner loader program 
loads collection data for the target using either of these two methods:

■ Using the Per Time Interval field to specify the number of loader passes for a 
specified time interval

■ Using the Time Between field to specify the length of time between loader 
passes

Note: Although data can be collected at short time intervals (such 
as 5, 10, or 15 minutes), collected data is not available to you for 
analysis until it has been loaded into the Oracle Capacity Planner 
historical database. Therefore, the load interval you specify controls 
when the most recently collected data will be visible to you.
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The collection frequency you set determines the lowest time interval for which 
Oracle Capacity Planner can analyze data.  For example, if you want to be able to 
analyze data from hourly intervals, you need to set a collection frequency of at least 
once an hour. 

After you define the frequency of loading collection data, you can set a time for the 
next loader pass by using the Next Transfer Occurs at field:

1. Click the value that you want to change in the date and time box.

2. Click the up or down arrow to select a higher or lower value.

If the current time is later than the time displayed for the Next Transfer Occurs 
at setting, click Refresh View to update the display to show the actual time of 
the next loader pass.

Note that the values that you select on the Storage Options property page apply to 
all classes of data collected on the selected target.

Understanding When the Loader Runs
The loader runs at the regular time interval specified on the Storage Options 
property page.  The time specified in the Next Transfer Occurs at field controls 
when the loader runs.  For example, if you want the loader to run once a day at 2:00 
a.m., then set the transfer interval to once per day, and set the next transfer time to 
the next day at 2:00 a.m.  The loader will run for the first time at 2:00 a.m. the next 
day, and then will run once a day, each day at 2:00 a.m.

You can use the Next Transfer Occurs at field to force the loader to run 
immediately—or as soon as possible. Simply set the next transfer time to a time 
earlier than the current time.

Understanding How Data Aggregation Works
As it loads data into the database, Oracle Capacity Planner automatically 
aggregates the data. During aggregation, Oracle Capacity Planner examines the 
collection samples for a given time interval, calculates an average value for that 
interval, then uses that average value for calculations at the next larger time 
interval.
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On each loader pass, Oracle Capacity Planner examines the time stamps of all 
collected data to determine whether or not the threshold for a set interval (hour, 
day, week, month, or year) has been crossed since the previous loader pass.  If so, 
Oracle Capacity Planner performs an aggregation of collected data from the next 
smaller interval to the interval threshold just passed.  Table 4–2 shows the larger 
time interval to which data at each time interval is aggregated.

An example may help clarify how Oracle Capacity Planner aggregates collection 
data.  Suppose Oracle Capacity Planner is collecting a data sample every 10 minutes 
to capture the percentage of used space on a particular disk, and the loader runs 
once an hour.   When the Oracle Capacity Planner loader runs and transfers data 
into the Oracle Capacity Planner database every hour, it examines the values for the 
percentage of used disk space in the samples collected during the previous hour, 
then it computes an average percentage for the samples.  That average percentage is 
then used as the average value for the hour. 

At the first loader pass after midnight, Oracle Capacity Planner uses the hourly 
averages since midnight the previous day to compute the day’s percentage of used 
disk space.  

At the first loader pass after midnight on Saturday, Oracle Capacity Planner 
examines the daily averages of used disk space since midnight the previous 
Saturday and computes an average percentage for the week.  

At the first loader pass after midnight on the last calendar day of the month, Oracle 
Capacity Planner examines the weekly averages since midnight on the last calendar 
day of the previous month and computes an average percentage for the month.  

Finally, at the first loader pass after midnight on December 31, Oracle Capacity 
Planner examines the last 12 monthly averages to compute a yearly average.

Table 4–2 Aggregation of Data from Smaller to Larger Time Intervals 

Data at This Interval Aggregates to This Interval

Minutes Hours

Hours Days

Days Weeks

Weeks Months

Months Years
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Defining the Amount of Data to Keep
The final step in setting up a target for historical data collection is defining the 
amount of data to keep.

When you select a target, you can click the Purge Options tab to display the Purge 
Options property page.  On this page, you specify the amount of data you want to 
store in the Oracle Capacity Planner historical database for each type of data (for 
example, hour data, day data, and week data).  You can accept the default Purge 
Options property page values or choose different values.

The values set on the Purge Options property page apply to all classes of data 
collected on the selected target.

The values you specify in the data retention table (the Enter the amount of data  
you want to keep table on the Purge Options page) determine how far back in time 
you can go to analyze data for the different types of data.

Suppose, for example, you always want to be able to view hour data for the 
previous six weeks.  In this case, for the Hours Data Type row in the data retention 
table, you would enter 6 in the Timespan column and Weeks in the To Keep 
column. This tells Oracle Capacity Planner that you want to keep hour data for a 
6-week period. Oracle Capacity Planner calculates 6 weeks from the current time, 
and the Purge Data Older Than column shows the time span for which hour data is 
available.  Table 4–3 shows the Hours row in the data retention table with this data 
entered.

For each row in the data retention table, you can choose the time span to keep data 
samples for that type of data by entering the desired value in the Timespan to Keep 
column.

Applying and Reverting the Collection Settings for a Target
When you finish setting all the options on the Target property sheet, do the 
following to apply your collection settings:

1. Click Apply.

Table 4–3 Specifying How Much Data to Keep for a Data Type 

Data Type Timespan To Keep Purge Data Older Than

Hours 6 Weeks (current date minus 6 weeks)
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If you changed the location of the historical database on the Storage Options 
page, Capacity Planner displays a message box reminding you that any 
information stored in the previous location will not be available for analysis.

If you don’t want to be reminded about this implication the next time you 
change the database location, select Don’t show this message again.

2. Click OK.

Capacity Planner displays a message stating that the options were set 
successfully.

3. Click Continue to close the message box and return to the Capacity Planner 
main window.

When you apply your collection settings, Capacity Planner sends the settings to the 
Agent for the selected target.  Note that you cannot select data to be collected until 
these settings have been applied.  

At any time during the process of modifying the settings on the Target property 
sheet, you may revert the settings to their last saved (applied) state by clicking 
Revert.  However, after you apply the settings, they cannot be reverted to their 
previous settings using the Revert button; they must be modified manually.

Selecting the Classes of Data to Collect
After you set the collection and loading options for a target, you can then select the 
classes of performance data that you want to collect for that target:

1. In collection view, select and connect to the target.

For more information, see "Selecting Targets"  on page 4-6. 

2. Click the plus sign (+) next to the target to show the classes of data you can 
collect.

3. Select one of the classes for the target.

Figure 4–3 shows a typical collection class for a node target on Windows NT and 
the data sources and data items available for the class.
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Figure 4–3 Selecting Data Sources and Data Items for a Collection Class

The following list explains classes, data items, and data sources in more detail:

■ Classes

A class is a container for a particular category of data. For example, a node (or 
operating system) target might include the following classes:

– System

– Processor

– Memory

When you select a target in the navigator, Capacity Planner displays the names 
of the classes below the target in the tree view.

You can collect data from none, some, or all displayed classes for a target.  A 
class may also be a container for other classes, to provide logical groupings of 
the performance data at higher levels.  For example, an I/O class may be a 
container for other more specific I/O classes.

■ Data items
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In a class, each of the related statistics is referred to as a data item.  For example, 
a LogicalDisk class might include the following data items:

– Percent Free Space

– Free Megabytes

– Current Disk Queue Length

– Disk Writes per Second

A class can contain one or more data items.  When you select a class in the 
navigator, the names of the data items and data sources associated with the 
data items are displayed on the Collection Details property page.  Select the 
data items that you are interested in collecting.  

A green check mark appears next to the name of each data item that is selected 
for collection.  You can toggle the state of all data items between collected and 
not collected by clicking the Data Items column header that contains the check 
mark.

■ Data sources

A data source is a description of where Oracle Capacity Planner can collect the 
data items for a class.  A class can contain one or more data sources.  When you 
select a class in the navigator, the names of the data items and data sources 
associated with the class are displayed on the Collection Details property page.

The type of data in the class determines the data sources for the class.  For 
example, in a LogicalDisk class, the data sources might be the individual disks 
for the operating system (for example, disk1, disk2, and so on).  In a CPU 
Utilization class, the sources are the individual CPUs for the host (for example, 
cpu1, cpu2, and so on). You can collect data items from one or more data 
sources.  

When you select a data source, a green check mark appears next to the name of 
the data source on the Collection Details property page. You can toggle the state 
of all data sources between collected and not collected by clicking the Data 
Sources column header that contains the check mark.

Starting Data Collection
After you select the data items that you want to collect from the available data 
sources on the Collection Details property page, click Apply to confirm your 
selections, or click Revert to cancel the selections.
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When you click Apply for a class of data, Capacity Planner marks the icon for the 
selected class and the selected target with a green dot in the Collection view of the 
navigator panel.  A green dot on a collection class icon indicates that one or more 
data sources are selected for the class. A green dot on a target icon indicates that 
Capacity Planner is collecting data for one or more classes in the target.

For example, in Figure 4–4, Capacity Planner is actively collecting data for the 
Processor, Memory, and Cache classes for node ANG-PC.  Capacity Planner is not 
collecting data for the System collection class.

Figure 4–4 Green Dots on a Target or Class Indicate Capacity Planner is Collecting 
Data

Stopping Data Collection
To stop collecting data for one or more data items or data sources for a collection 
class, follow these steps:

1. Select the collection class in the navigator.

2. On the Collection Details page, click on the green check marks for those data 
items or data sources from which you no longer want data collected, which 
causes the check marks to disappear.

3. Click Apply.

To stop collecting data for all data items and data sources for a collection class, 
follow these steps:

1. Select the collection class in the navigator.

2. On the Collection Details page, click Stop Collection.

Capacity Planner displays a message box stating that collections for the class 
have stopped.

3. Click OK to close the message box and return to the Capacity Planner main 
window.
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When no data sources are selected for collection for a class of data, the icon for 
that class in the navigator does not display a green dot.

To stop collecting data for all classes in a target:

1. In collection view, select and connect to the target.

For more information, see "Selecting Targets"  on page 4-6. 

2. Click Stop Collection on the Target property sheet.

Capacity Planner displays a confirmation box.

3. Click Yes to stop collecting data for all classes in the target; click No to cancel 
the operation.

Generating a Collection Report
A collection report provides a summary of the collection settings for one or more 
targets. Capacity Planner displays the collection settings in your Web browser. In 
the browser, you can easily review the settings currently applied to the target or 
targets you selected.

To display a collection report for one or more targets:

1. In collection view, on the File menu, choose Collection Report.

Capacity Planner displays the first screen of the Collection Report Wizard.

2. Use the Collection Report Wizard to specify the target or targets whose 
collection settings you want to include in the report and to generate and view 
the report.

At any time while using the wizard, click Help for more information.

When you click Finish on the last screen of the Collection Report Wizard, Capacity 
Planner saves the report to an HTML file and displays the report in your Web 
browser.

Copying Collection Settings
After you set up collection settings for one service, you can quickly copy those 
settings to another similar target.

To copy the collections settings from one target to another:

1. In collection view, select a target whose collection settings you want to copy.
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2. On the File menu, choose Copy Collection Settings or right mouse click on the 
Collection Settings from the context menu.

Capacity Planner displays the first screen of the Copy Collections Wizard.

3. Use the Copy Collection Settings Wizard to specify the destination targets to 
which you would like to copy the collection settings for the selected target.

From the wizard, you can also view the progress of the copy operation. At any 
time while you are using the Copy Collection Settings Wizard, click Help for 
more information.

Troubleshooting Collection and Load Problems
During the collection and load processes, errors may be encountered by the Agent.  
You can determine if data is not being collected or loaded by using either of these 
methods:

■ Browsing the analysis data in the Oracle Capacity Planner navigator.  See 
"Browsing the Collected Data" on page 4-21 for more information.

■ Accessing the historical database using SQL.  See "Understanding the Oracle 
Capacity Planner Historical Database" on page 4-36 for more information.

If data is not being collected or loaded, you should check the status of the Agent on 
the host from which data is being collected.  If the Agent is running, check the log 
file ($ORACLE_HOME/network/log/dbsnmp.log) for errors related to the 
collection or loading of data. See "Managing the Agent" on page 2-11 for more 
information on managing the Agent.

Analyzing Collected Data
After collected data is loaded into the Oracle Capacity Planner historical database, 
you can perform a variety of analyses on it. To access the analysis features of Oracle 
Capacity Planner, click the Analysis tab (Figure 4–5) at the bottom of the Oracle 
Capacity Planner navigator tree view.  This displays the Oracle Capacity Planner 
analysis view.

Note: Any destination target you select must be running an Agent 
of the same type and version as the target from which you are 
copying your settings.
Introduction to Oracle Capacity Planner 4-19



Analyzing Collected Data
Figure 4–5 Clicking the Analysis Tab

Connecting to an Oracle Capacity Planner Historical Database
When you expand the Historical Database folder at the root of the navigator tree in 
analysis view, you are prompted for the logon credentials for an Oracle Capacity 
Planner historical database.  

After you connect to a historical database, the folder expands to show the targets for 
which data is available in that historical database.

If you store data in multiple historical databases, you must disconnect from one 
historical database before you can connect to a different historical database.  

To disconnect from the current historical database, 

1. Click the Historical Database folder at the root of the navigator tree.

2. Click the Disconnect button in the Capacity Planner toolbar panel.

To connect to a different historical database, expand the Historical Database folder 
again and enter the credentials for the new historical database in the resulting logon 
dialog box.

Organization of Data in the Navigator
When you expand a target in the navigator under the Historical Database folder, 
two forms of data are displayed below the target:

■ Classes of data
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The classes displayed for the target are the collection classes for which data is 
available in the Oracle Capacity Planner historical database.  You can select and 
view data from these classes by selecting a class in the navigator, specifying the 
selection criteria, and then clicking Show New Chart.  These operations are the 
first step in creating an analysis.

■ Analyses

Below each target in the navigator is an Analyses folder, which contains 
predefined and user-defined analyses.  Predefined analyses are provided for 
some targets. You can create user-defined analyses by selecting a class of data, 
displaying an analysis of the data, and then saving the analysis.  You can also 
create a user-defined analysis by using an existing analysis as a template, 
making modifications to the analysis, and then saving the analysis under a new 
name.

Browsing the Collected Data
To browse the collected data for a particular target:

1. In analysis view, expand the Historical Database folder.

You are prompted for the credentials for the historical database that contains 
the collected data that you want to analyze.

2. Enter your logon credentials and connect to the historical database.

3. On the navigator panel, expand the folder for the target whose collected data 
you want to analyze.  

The navigator displays the:

■ Names of the classes for which collected data exists in the historical 
database for the target

■ An Analyses folder, which contains predefined and user-defined analyses 
you created for the target

Viewing an Analysis for a Class of Data
To view an analysis chart for a selected class of data:

1. On the navigator panel, click the name of a class whose collected data you want 
to analyze.

Capacity Planner displays the property page for the class (Figure 4–6).
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2. To specify the selection criteria for the class of data you want to analyze, see 
"Specifying Selection Criteria for a Class of Data" on page 4-23 for instructions.

3. Click Show New Chart.

Capacity Planner displays the Analysis window, which contains two or more 
pages.  The Chart page displays the chart.  The remaining pages are Details 
pages.  A separate Details page exists for each class from which one or more 
data items are included in the analysis.  

For information about the Analysis window, choose Window from the Analysis 
window Help menu.  For information about modifying the analysis or 
changing the way the data is displayed, see "Working with Analyses" on 
page 4-27.

Saving a Class Analysis as a User-Defined Analysis
After you view an analysis for a class of data, you can save it as a user-defined 
analysis to view later.

To save the analysis:

1. While viewing the analysis chart, click Save Chart on the analysis window 
toolbar.

2. Click Yes in the message box.

Performance Manager places the new user-defined analysis in the Analyses 
folder of the navigator panel.
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Figure 4–6 Oracle Capacity Planner Analysis View

Specifying Selection Criteria for a Class of Data
When you select a class in the navigator panel in analysis view, Capacity Planner 
displays a property sheet that contains options available for selecting data from the 
Oracle Capacity Planner historical database for that class.

Before you display a chart of the collected data you must:

1. Select the time aggregation level from the Time Aggregation drop-down list.

For example, select Hours if you want to analyze hourly data, Days if you want 
to analyze daily data, and so on.

2. In the Data Sources section, select one or more data sources whose data items 
you want to analyze.  

3. In the Data Items section, select one or more data items you want to analyze.  

A check mark appears next to each data item that is selected for analysis.

4. If you have selected a class of data for which a hierarchical analysis chart can be 
displayed, a Show <label> button appears next to the Time Aggregation list 
box. The SAP R/3 Buffer Data class is an example of a class for which a 
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hierarchical chart can be displayed. In the SAP R/3 Buffer Data class, the parent 
data sources are the application instances for which historical data has been 
collected, and the child data sources are the individual SAP R/3 buffers (for 
example, CALE, CUA, FTAB, and so on) for those application instances.

The name of the Show <label> button changes depending on the child data 
sources available for the parent data sources that you have selected on the class 
property page in analysis view.

To choose the child data sources whose data items you want to view in the 
analysis, click the Show <label> button to display the Select Data Sources for 
Analysis dialog box, then follow these steps:

a. Choose the name of the parent data source in the list box. In the table below 
the list box select the names of the child data sources whose data item 
values you want to view for that parent data source. Repeat this step for 
each parent data source. You can select different child data sources for each 
parent data source.

b. Click OK when you have selected child data sources for all of the parent 
data sources.

After you specify the selection criteria, there are two ways to display the data in an 
analysis chart:

■  To add the selected data to a new analysis chart, click Show New Chart, 
which displays the new chart. 

■ To add the selected data to an analysis chart that is already displayed in the 
Analysis window, click Add to Chart, then in the Add Data to Analysis 
dialog box, select the name of the previously-displayed analysis chart. Note 
that only charts that are currently opened are displayed in the Add Data to 
Analysis dialog box.

Viewing and Modifying User-Defined and Predefined Analyses
You can view and modify both user-defined and predefined analyses.  However, 
once modifications are made to a predefined analysis, the only way to save those 
changes is to save the analysis to a new name.  This creates a new user-defined 
analysis and preserves the original predefined analysis.

Note: Not all targets provide predefined analyses.
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To view an existing analysis, which makes it available for modification, follow these 
steps:

1. Expand the Analysis folder for the target, which displays the existing 
predefined and user-defined analyses for the target.

A bar chart icon identifies a predefined analysis. Not all targets provide 
predefined analyses.

A bar chart and person icon identifies a user-defined analysis. You create a 
user-defined analysis by displaying an analysis for a class of data or displaying 
a predefined analysis, and then saving the analysis.

2. Select a predefined analysis or user-defined analysis in the navigator panel. 

The Analysis Summary property page for the selected analysis is displayed in 
the detail panel.  This property page displays the names of the targets and 
classes whose data is used in the analysis.

3. To view the data sources and data items in the analysis, click the plus sign (+) 
next to the target icons in the Service/Source column.

4. To view the chart for the analysis, click Show.  

Note that if you are opening a predefined analysis, Capacity Planner displays 
the Select Data Sources for Analysis dialog box.  Predefined analyses are 
provided for some targets. Predefined analyses require you to specify the 
available data sources for your installation.  Select the data sources you want to 
include in the predefined analysis and click OK.

After you have opened an analysis, you can modify the contents and how they are 
presented.  See "Working with Analyses" on page 4-27 for more information.

You can also create a copy of an analysis, rename an analysis, or delete an analysis, 
as explained in the next three sections.

Note: You can limit the list of displayed analyses to only 
user-defined analyses by removing the check mark from the View 
Predefined Analyses option on the Analysis menu.  When you 
choose the View Predefined Analyses option on the Analysis 
menu again, the check mark preceding the menu option is replaced, 
and predefined analyses are displayed again.
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Creating a Copy of an Analysis
You can create an analysis that is an exact copy of an existing analysis, but the copy 
has a different name.  To do this:

1. In analysis view, locate and expand the target that contains the analysis you 
want to copy.

2. Expand the Analyses folder.

3. Select the analysis you want to copy.

4. On the Analysis menu, choose Create Like.

5. In the Create Analysis Like dialog box, enter a unique name for the new 
analysis that you are creating and click OK.

Capacity Planner creates the new copy of the analysis in the Analyses folder for 
the target.

Renaming a User-Defined Analysis
 

To rename a user-defined chart:

1. In analysis view, locate and expand the target that contains the analysis you 
want to rename.

2. Expand the Analyses folder.

3. Select the user-defined analysis you want to rename.

A bar-chart-and-person icon identifies user-defined analyses.

4. On the Analysis menu, choose Rename.

5. In the Rename Analysis dialog box, enter a unique name for the analysis you 
are renaming and click OK.

Note: You cannot rename a predefined analysis.  This restriction 
ensures that the original predefined analysis charts are not 
overwritten.

However, after you make changes to a predefined analysis, you can 
save the modified version of the predefined analysis as a 
user-defined chart with a new name.  For more information, see 
"Saving the Results of a Predefined Analysis" on page 4-35.
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Deleting a User-Defined Analysis

To delete a user-defined analysis:

1. In analysis view, locate and expand the target that contains the analysis you 
want to delete.

2. Expand the Analyses folder.  

A bar-chart-and-person icon identifies the user-defined analyses in the folder.

3. Select the user-defined analysis that you want to delete.

4. On the Analysis menu, choose Delete.

5. In the message dialog box that prompts you to confirm the deletion, click OK.

Working with Analyses
After you have opened an analysis chart, either by selecting and showing an 
existing analysis or by browsing collected data to create a new analysis, the data 
included in that analysis is shown in the Oracle Capacity Planner Analysis window.

The Analysis window contains two or more pages.  The first page is called the 
Chart page and it displays the analysis chart.  The remaining page or pages are 
Details pages.  A separate Details page exists for each class from which one or more 
data items are included in the analysis.  Each Details page shows the:

■ Data sources for the data items plotted in the chart

■ Time aggregation level of the plotted data items

■ Value of each plotted data item each time the data item was collected during the 
time range for the analysis

The time range for the collected data appears along the bottom of each chart, with 
the beginning of the time range at the left and the end of the time range at the right.

Two types of lines can appear on a chart.  Each solid line plots the values of a 
selected data item during the specified time range.  Each dashed line plots the result 
of a trend analysis to time or trend analysis to value.  See "What Is a Trend 
Analysis?" on page 4-32 for more information about performing a trend analysis.

The rest of this section describes other features of the Analysis window.

Note: You cannot delete a predefined analysis.
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Viewing the Value of a Data Point
To view the value for a data point (that is, one plotted point of a data item) on a line 
in an analysis chart, position the cursor over the data point.  If there is a point 
beneath the cursor, Capacity Planner displays the date, time, and value for that data 
point displays in a box above the point (see Figure 4–7).

Figure 4–7 Viewing the Value of a Data Point

Selecting a Line
When you view an analysis chart, you can perform certain operations after selecting 
a line in the chart.  Most of the available operations are started by clicking a toolbar 
button on the analysis window after a chart line is selected.  

To select a line, click a data point on the line. When a line is selected, the description 
of the line is displayed in the status bar at the bottom of the window, and the 
appropriate toolbar buttons are enabled.

Operations available from the toolbar are also available on a context menu.  To 
display the context menu, click the right mouse button on a data point in a line in 
the analysis chart.

To be sure which line is currently selected (before clicking a toolbar button), read 
the description of the line in the status bar.

Adding a Class of Data to an Analysis
After you open an analysis, you may want to add data from other classes to the 
analysis. You can use this feature to compare two different classes of data.

To add a class of data to an analysis that is currently displayed in the Analysis 
window:

1. Confirm that Capacity Planner is in analysis view.

2. Select from the navigator the class of data that you want to add.
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3. Specify the selection criteria (as described in "Specifying Selection Criteria for a 
Class of Data" on page 4-23) for the class.

4. Click Add to Chart.

5. In the Add Data to Analysis dialog box, select the name of the chart to which 
you want to add the data.

You can add data items from multiple classes to an analysis, and you can select 
different aggregation levels and date ranges for each class.  

However, data items within a single class must share the same aggregation level 
and date range.  If you try to add additional data items from the same class to an 
existing chart, you will receive a prompt, warning that the chart already contains 
data from this class.  If you click OK, Capacity Planner will overwrite the chart with 
the currently selected data, aggregation levels, and date range.

Modifying Selection Criteria from the Analysis Window
From the analysis window, you can modify the selection criteria associated with 
any of the classes of data included in the analysis. Modify the selection criteria 
using one of these methods:

■ Select a line in the analysis chart and click the Select Items toolbar button.

■ Click the right mouse button on a data point in the line and choose Select Items 
from the context menu.

■ Click the Data tab in the analysis window (as opposed to the Chart tab) and 
click the Select Items toolbar button.

These actions display the Select Items dialog box, which contains the property sheet 
for the class of data associated with the selected line.  This property sheet contains 
the selection criteria for that class of data, which you can modify and apply to the 
current analysis. See "Specifying Selection Criteria for a Class of Data" on page 4-23 
for more information.

After you modify selection criteria, you can click either Apply or OK on the 
Analysis Options dialog box.  If you click Apply, the changes made to the selection 
criteria are applied to the analysis and the updated analysis is shown.  The Select 
Items dialog box remains displayed, and you can make other modifications to the 
same selection criteria, if you want.  If you click OK, Capacity Planner applies the 
modifications to the analysis and closes the Select Items dialog box.
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Removing a Line from a Chart
You can remove a line from an analysis chart by either of these methods:

■ Select the line by clicking the right mouse button, then choose Remove Line 
from the context menu.

■ Select the line, then click the Remove Line button on the analysis window 
toolbar.

These actions remove the data for the selected data item from the chart, but not 
from the historical database.

Excluding a Data Point from a Chart
You can exclude a data point (that is, one plotted point of a data item) from a chart. 
To exclude a data point, click the right mouse button on the data point and choose 
Exclude Point from the context menu.

Excluding a data point is useful if you know that the value of a particular data point 
is skewed.  For example, if you know that a particular CPU-intensive program was 
not run at the usual time, you can remove the value for the % Processor Time data 
item for that time from the chart.  The selected data point is removed from the chart, 
but the data for the data point is not removed from the historical database.

After you exclude one or more data points from a line, a red X appears in the status 
bar when you select the line.  

To later redisplay excluded data points for a selected line, click View Exclusions on 
the Analysis window toolbar, or click the right mouse button on the line and select 
View Exclusions  from the context menu.

These actions display the Data Point Exclusions dialog box, which displays the 
current list of excluded points for the selected line.  You can toggle the check mark 
for each data point in the list.  A check mark indicates that the data point is 
excluded from the analysis.  To display an excluded data point in the analysis again, 
clear the check mark.  

When you click OK, Capacity Planner closes the Data Point Exclusions dialog box 
and updates the chart to include the points removed from the list of exclusions.

Showing or Hiding the Chart Legend

Note: Data point exclusions are not saved with an analysis.
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You can control whether or not the legend is displayed in an analysis chart by 
toggling the Show/Hide Legend button on the analysis window toolbar.  When the 
legend is not shown, you can identify a line by clicking it, which displays the 
description of the line in the analysis window status bar.

Zooming and Scrolling to View More or Less Chart Data
Depending on the date range and the number of data items and data sources you 
are analyzing, you may want to zoom in, zoom out, or scroll the contents of the 
chart window.

To view more detail or less detail, click the Zoom In and Zoom Out buttons on the 
Analysis Chart window toolbar. You can also zoom in by pressing the Page Down 
key on your keyboard or the numeric 3 on your keypad, and you can zoom out by 
pressing the Page Up key or the numeric 9 on your keypad.

You can also zoom in on a very specific part of the chart by dragging a rectangle 
around the area you want to magnify (Figure 4–8). Release the mouse button to 
zoom in on the selected area. You can zoom back out by using the Zoom Out button 
Home or End key on your keyboard.

Figure 4–8 Zooming in on a Selected Area of the Chart

Often, the chart data will extend beyond the width of the Analysis Chart window.  
You can view the data that extends beyond the edges of the window by resizing the 
Analysis Chart window or by scrolling to the right or left.

To scroll the Analysis chart window:

1. Press and drag the pointer on the black scroll bar below the chart (Figure 4–9).

2. When the portion of the chart you want to view is displayed in the Analysis 
Chart window, release the mouse button.
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Optionally, you can use the arrow keys on your keyboard to scroll left and right. 
Press the left arrow to scroll left and the right arrow to scroll right. If you experience 
a conflict with the Tab function using the left and right arrow keys, you can use the 
up and down arrow keys on your keyboard to scroll. Press the up arrow to scroll 
left (or the numeric 8 on your keypad), or the down arrow key to scroll right (or the 
numeric 2 on your keypad). 

Figure 4–9 Scroll Bar in the Analysis Chart Window

Auto-Scaling Data
If an analysis contains data from different classes where the scale of the data is 
significantly different, you may want to apply scaling to the data.  Scaling 
normalizes the data so that all lines have a maximum value of no greater than 100.  
Very large data items are scaled down, and very small data items are scaled up.

To apply scaling, click Toggle Auto Scaling on the analysis window toolbar.  When 
scaling is applied to a chart, data lines with very different scales may be visually 
correlated.  When scaling is enabled, Capacity Planner displays the label Scaled 
Data along the Y-axis of the chart. If you select a line from the chart by clicking it, 
the scaling factor for that line is included in the status bar.

What Is a Trend Analysis?
A trend analysis infers or estimates future values by projecting and extending 
known values.  Oracle Capacity Planner can perform the following types of trend 
analyses:

■ Trend analysis to a point in time 

In a trend analysis to a point in time, you provide a goal time for a data item. 
Oracle Capacity Planner uses the specified values in the historical database to 
project the value of the data item at the goal time.
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A trend analysis to a point in time is used to answer questions such as, "How 
full will this disk be at the end of the year?"

■ Trend analysis to a value 

In a trend analysis to a value, you provide a goal value for a data item.  Oracle 
Capacity Planner uses the specified values in the historical database to project 
the time at which the data item will reach the goal value.

A trend analysis to a value is used to answer questions such as, "When will our 
CPU utilization reach 95 percent?"

As the default, the Capacity Planner Trend Analysis wizard uses the critical 
threshold for the metric (if one is defined) when you perform a trend to a value.

Specifying and Performing a Trend Analysis
To specify and perform a trend analysis, follow these steps:

1. In the Analysis window, either:

■ Select a line by clicking a data point in the line, then click the Trend 
Analysis Wizard button on the toolbar.

■ Click the right mouse button on a data point in a line, then select Trend 
Analysis Wizard from the context menu.

Both of these methods display the Trend Analysis Wizard.

2. Capacity Planner displays the Trend Analysis Wizard Welcome panel that 
identifies the selected data on which you can conduct the trend analysis. You 
can click on the option box that prevents the Welcome screen from displaying in 
subsequent uses of the wizard. Click on Next to move to the next wizard panel.

3. In the Date Range panel, select a date range to use as a basis for the trend 
analysis:

■ Click Use only the visible date range (as currently zoomed in the chart) to 
use the range of dates currently visible in the analysis chart window (not 
including any data that extends beyond the edge of the chart window).  

This option is enabled only if you zoomed in to see more detail in the chart. 
For more information, see "Zooming and Scrolling to View More or Less 
Chart Data" on page 4-31.

■ Click Use the date range selected for the chart to use the date range 
currently used for all the data in the chart (even data that extends beyond 
the edge of the chart window).  
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■ Click Select a new chart range to select a different date range . You can 
designate either a recent period of time by choosing Use a recent period of 
time and then selecting the time increment and number of units of time to 
use, or you can specify a new start and end time by choosing Use a new 
start and end time.

■ Click on Next to move to the next wizard panel.

4. In the Trend Analysis Type panel of the wizard, specify which type of trend 
analysis you want to perform.

■ To perform a trend analysis to a value, click the Estimate when the data 
item will reach the following value: and enter the numeric value for which 
you wish to determine the date and time.

■ To perform a trend analysis to a future date and time, click Estimate what 
the value of the data item will be at the following date: and enter the time 
and date for which you wish to determine a value.

■ Click on Next to move to the next wizard panel.

5. The Summary panel displays the results of the trend analysis. Click on Finish  
to add the trend line to the chart. 

6. Choose Customize Annotation from the View menu to display the Annotate 
Trend dialog box and make changes to the annotation. Optionally, you can right 
mouse button click on the annotation created by the Trend Analysis wizard and 
then choose Customize Annotation from the context menu. 

Use the Annotate Trend dialog box to specify whether Capacity Planner will 
annotate the trend analysis (see Figure 4–10) and the appearance of the trend 
analysis line in the chart window. If you need information about the fields in 
the Annotate Trend dialog box, click Help.

Figure 4–10 Annotation for a Trend Analysis

7. Click OK to close the Annotate Trend dialog box.
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Saving Changes to a User-Defined or Predefined Analysis
You can save the changes you make to an analysis.  Oracle Capacity Planner can 
determine if you are saving a user-defined analysis or a predefined analysis.  The 
steps for saving your changes differ, depending on the type of analysis.

Saving the Results of a User-Defined Analysis
To save changes to a user-defined analysis:

1. While viewing the analysis, click Save Chart on the analysis window toolbar.

2. Click Yes in the message box.

Your changes are saved to in the Analysis folder for the selected target using the 
current name of the analysis or data class.  To save the analysis under a 
different name, choose Save As from the Analysis window File menu.

Saving the Results of a Predefined Analysis
If you modify a predefined analysis, you must provide a new name for the analysis 
when you save the results of the analysis.  When you do this, you create a new 
user-defined analysis.  Saving the analysis with a new name ensures that the 
original predefined analysis is not overwritten.

To save the results of a predefined analysis:

1. While viewing the analysis, click Save Chart on the analysis window toolbar.

2. Click Yes in the dialog box that is displayed.

3. In the Save Analysis As dialog box, type a unique name for the user-defined 
analysis that will be created.

4. Click OK in the Save Analysis As dialog box.

Capacity Planner places the new user-defined chart in the Analyses folder of 
the navigator panel.

Note: To move the annotation box in an analysis chart, click the 
box, hold the mouse button down, then move the mouse to a 
different position on the chart.  Release the mouse button when you 
have reached the position in the chart where you want the 
annotation box displayed.
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Printing an Analysis Chart
To print an analysis chart, click the Print Chart button in the Analysis Chart toolbar 
while the chart is displayed.

The size of the chart on the screen determines the size of the chart in the chart 
printout. For example, when you print a chart that is 5 inches high and 7 inches 
wide on your screen, the chart will be 5 inches high and 7 inches wide in the 
printout.

Generating a Report for an Analysis Chart
To generate an HTML report for an analysis chart:

1. Click the Report Chart button while the chart is displayed.

Capacity Planner displays a dialog box that tells you the name of the HTML file 
used to display the report and where the file will be saved. 

2. Make a note of the file name and location.

3. Click Yes to preview the chart in your Web browser, or click No if you do not 
want to preview the report.

You can view the report later using a Web browser, or—if you have experience with 
Web publishing tools and techniques—you can share the report with your 
co-workers by publishing the HTML file and its associated graphic files on a Web 
server. 

Understanding the Oracle Capacity Planner Historical Database
The logical structure of the Oracle Capacity Planner historical database schema was 
designed to facilitate querying of capacity planning data by tools other than Oracle 
Capacity Planner, such as Microsoft Excel.  This section contains a brief description 
of the design of the Oracle Capacity Planner historical database schema.  It is not 
intended to be a comprehensive description of all tables and columns in the schema.

Caution: Performing any modification to the Oracle Capacity 
Planner historical database schema (tables, columns, or indexes) or 
to the data itself is not recommended and is not supported.  Such 
modifications may render your Oracle Capacity Planner historical 
database schema unusable as a target to load or retrieve capacity 
planning data.
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Understanding the Service Reference Table (vp_service_ref)
The service reference table contains a list of all targets for which data has been 
stored in the Oracle Capacity Planner historical database.  The HOST column 
contains the name of the host where the Agent that loaded data for the specified 
target (the NAME column) is located.  The SVC_ID column is a column used for 
lookup into the class reference table, described in the following paragraph.

Understanding the Class Reference Table (vp_class_ref)
The class reference table contains a list of all collection classes for which data has 
been stored in the Oracle Capacity Planner historical database, for all targets.  To see 
the list of classes for a particular target, a query should look for the SVC_ID column 
equal to a SVC_ID value from the service reference table, described in the previous 
paragraph.  Such a query would produce a list of all classes for which data exists in 
the database for a particular target.

Understanding the Data Tables
Each class of data in the class reference table has six data tables that contain the data 
for that collection class.  Each table contains data for a particular time aggregate, for 
example, hours, days, weeks, months, and years.  The base table contains the raw 
data as it is collected at the collection frequency.  Therefore, the base table does not 
contain any statistical aggregations.  The aggregate tables contain aggregate 
statistics for each data item collected for that class.

Data Table Names
Data tables are named according to the first four columns of the class reference table 
(in reverse order) plus the aggregate.  Example 4–1 shows an entry for a collection 
class in the class reference table.

Example 4–1 Collection Class Entry in the Class Reference Table

CLS_ID      MOD_ID     SVC_ID     IS_UDS      CONTAINER_CLASS_LABEL
---------- ---------- ---------- ---------- -------------------------------
         8          2          2          0 I/O

The collection class in Example 4–1 would have the data tables shown in 
Example 4–2.
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Example 4–2 Data Tables for a Collection Class

VP_0_2_2_8_BASE
VP_0_2_2_8_HOUR
VP_0_2_2_8_DAY
VP_0_2_2_8_WEEK
VP_0_2_2_8_MONTH
VP_0_2_2_8_YEAR

Data Table Contents
The first two columns of each data table are always the Timestamp column and the 
Data Source Name column.  The Data Source Name column is essentially the class 
name, for example, Logical Disk. In aggregate tables (tables other than BASE), the 
third column is an accuracy calculation, which is not supported in this version of 
Oracle Capacity Planner.

All subsequent columns contain the values for the data items collected for that class, 
as they are actually named.  In aggregate tables, these columns are prefixed with a 
two-character abbreviation for the aggregation statistic that the column contains.  
Table 4–4 shows these abbreviations and their meanings.

These statistics are calculated for the set of data in that aggregate from the next 
lowest level.  For example, a row in the DAY aggregate table contains statistics 
calculated for all entries in the HOUR table for that day.

Table 4–4 Prefixes Used for Column Names in Aggregate Tables 

Prefix Meaning

AV Average

SM Sum

MN Minimum

MX Maximum

SD Standard deviation

VR Variance

CT Count
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Introduction to SAP Event Tests

The Event Management System (EMS) within Oracle Enterprise Manager assists the 
DBA with automatic problem detection and correction. Using the EMS, the DBA 
can establish boundary thresholds for warnings and alerts conditions within the 
network environment in order to avoid potential problems.

The Oracle Enterprise Manager console provides event management functionality 
with the basic UpDown event tests.

The Oracle Management Pack for SAP R/3 provides some SAP event tests and 
some node event tests. Most of these event tests can be customized with 
user-defined thresholds and monitoring intervals. The user can establish an 
event-metric threshold and an occurrence threshold. Event-metric thresholds can be 
set at a warning level and at an alert level. When the thresholds are met or 
exceeded, the user is notified. The user can specify how often the Event 
Management System should check for the existence of an exceeded event-metric 
threshold.

For information on using the Oracle Event Management System,  see the Oracle 
Enterprise Manager Administrator’s Guide.

SAP Event Tests
This section describes the SAP event tests that are provided with the Oracle 
Management Pack for SAP R/3. The SAP event tests can only be registered on SAP 
R/3 services. To register an SAP event test on an SAP R/3 service, the 9.0.1 
Intelligent Agent must be running on the NT proxy machine that refers to the SAP 
R/3 system in its sap.conf file. See "Configuring the NT Proxy Machine to Manage 
SAP R/3 Data" on page 2-5 for more information about configuring the NT proxy 
machine and the sap.conf file.
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Note that in the Oracle Enterprise Manager console you must specify preferred 
credentials for any service on which you want to register events. See "Setting 
Preferred Credentials" on page 2-17 for more information on specifying preferred 
credentials.

Buffer Quality (%)
This event test checks for the buffer quality of SAP buffers. Performance of an SAP 
application instance will deteriorate when buffer hit ratio decreases. If the 
percentage of the buffer hit ratio is lower than the value specified in the threshold 
arguments, a warning alert or a critical alert is generated.

Parameters
1. SAP buffer name: Enter the name of the buffer to be monitored. The valid 

buffer names are:

■ CALE

■ MDH

■ CUA

■ SNTAB

■ PRES

■ FTAB

■ IRBD

■ TABL

■ TABLP

■ PXA

■ EIBUF

■ TTAB

2. Critical threshold: Threshold value for critical alert (%). Default is 90%.

3. Warning threshold: Threshold value for warning alert (%). Default is 95%.

Output
The name of the buffer

Current buffer quality (%)
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Default Frequency
60 seconds

User Action
Check the configuration of the application server and increase (if possible) the 
buffer that caused the trouble.

Work Process Response Time (sec)
This event test checks for the response times of dialog work processes. The response 
time of dialog work processes gives a good overview of the system performance. If 
the response time exceeds the values specified in the threshold arguments, then a 
warning alert or critical alert is generated.

When you create this event test, on the General page of the Create Event dialog box, 
choose only one SAP R/3 instance with which to populate the Monitored 
Destinations list.

Parameters
1. Response Time Data: Enter the name of the SAP R/3 instance that you selected 

on the General page of the Create Event dialog box in the following format:

smpsmn3_AT3_00

In this format, smpsmn3 is the node name of the SAP R/3 message server, AT3 
is the SAP R/3 system ID, and 00 is the system number of the SAP R/3 
instance.

2. Critical threshold: Threshold value for critical alert, in seconds. Default is 6 
seconds.

3. Warning threshold: Threshold value for warning alert, in seconds. Default is 2 
seconds.

Output
Application instance name

Current response time

Default Frequency
60 seconds

User Action
Check the configuration of the application server.
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In-Memory Roll Area Used (%)
This event test checks for the size of the used roll area. If the percentage of used 
in-memory roll area exceeds the values specified in the threshold arguments, then a 
warning alert or critical alert is generated.

When you create this event test, on the General page of the Create Event dialog box, 
choose only one SAP R/3 instance with which to populate the Monitored 
Destinations list.

Parameters
1. SAP R/3 Memory Data: Enter the name of the SAP R/3 instance that you 

selected on the General page of the Create Event dialog box in the following 
format:

smpsmn3_AT3_00

In this format, smpsmn3 is the node name of the SAP R/3 message server, AT3 
is the SAP R/3 system ID, and 00 is the system number of the SAP R/3 
instance.

2. Critical threshold: Threshold value for critical alert (%). Default is 95%.

3. Warning threshold: Threshold value for warning alert (%). Default is 85%.

Output
Application instance name

Current used space in percentage

Default Frequency
60 seconds.

User Action
Check the configuration of the application server and increase the size of the roll 
area.

In-Memory Page Area Used (%)
This event test checks for the size of the used page area. If the percentage of used 
in-memory page area exceeds the values specified in the threshold arguments, then 
a warning alert or critical alert is generated.

When you create this event test, on the General page of the Create Event dialog box, 
choose only one SAP R/3 instance with which to populate the Monitored 
Destinations list.
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Parameters
1. SAP R/3 Memory Data: Enter the name of the SAP R/3 instance that you 

selected on the General page of the Create Event dialog box in the following 
format:

smpsmn3_AT3_00

In this format, smpsmn3 is the node name of the SAP R/3 message server, AT3 
is the SAP R/3 system ID, and 00 is the system number of the SAP R/3 
instance.

2. Critical threshold: Threshold value for critical alert (%). Default is 95%.

3. Warning threshold: Threshold value for warning alert (%). Default is 85%.

Output
Application instance name

Current used space in percentage

Default Frequency
60 seconds.

User Action
Check the configuration of the application server and increase the size of the page 
area.

Extended Memory Used (%)
This event test checks for the size of the used extended memory. If the percentage of 
used in-memory extended memory increases the values specified in the threshold 
arguments, then a warning alert or critical alert is generated.

When you create this event test, on the General page of the Create Event dialog box, 
choose only one SAP R/3 instance with which to populate the Monitored 
Destinations list.

Parameters
1. SAP R/3 Memory Data: Enter the name of the SAP R/3 instance that you 

selected on the General page of the Create Event dialog box in the following 
format:

smpsmn3_AT3_00
Introduction to SAP Event Tests 5-5



Node Event Tests
In this format, smpsmn3 is the node name of the SAP R/3 message server, AT3 
is the SAP R/3 system ID, and 00 is the system number of the SAP R/3 
instance.

2. Critical threshold: Threshold value for critical alert (%). Default is 95%.

3. Warning threshold: Threshold value for warning alert (%). Default is 85%.

Output
Application instance name

Current used space in percentage

Default Frequency
60 seconds.

User Action
Check the configuration of the application server and increase the size of the 
extended memory.

Node Event Tests
This section describes the Node event tests that are provided with the Oracle 
Management Pack for SAP R/3. The Node event tests can be registered on any node 
on which an Intelligent Agent is running.

Node UpDown
This event test checks whether a node is up or down. If the node is down, this event 
is triggered.

Parameters
none

Output
none

Default Frequency
60 seconds

User Action
Restart the node.
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Data Gatherer UpDown
This event test checks whether the Oracle Data Gatherer being monitored is 
running. If the Oracle Data Gatherer is down, this event is triggered.

Parameters
none

Output
none

Default Frequency
60 seconds

User Action
Restart the Oracle Data Gatherer.

Data Gatherer Alert
This event test signifies that the Data Gatherer has generated errors to the Data 
Gatherer alert log file since the last sample time. The Data Gatherer alert log file is a 
special trace file containing a chronological log of messages and errors. Note that 
the Data Gatherer alert log file is different than the Database alert log file. An alert is 
displayed when Data Gatherer (ODG-xxxxx) messages are written to the Data 
Gatherer alert log file.

Parameters
none

Output
Alert log error messages since last sample time.

Default Frequency
60 seconds

User Action
Examine the Data Gatherer alert log file (alert_dg.log) for additional information. 
The alert log file can be found in the ORACLE_HOME/odg/log directory for the 
Intelligent Agent.
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Disk Full
This event test checks for available space on the disk specified by the Disk name 
parameter. If the space available is less than the values specified by the thresholds, 
then a warning alert or critical alert is generated.

Parameters
1. Disk name: Name of the disk to be monitored. No default is provided.

2. Critical threshold: Free space threshold in kilobytes for critical alert. No default 
is provided.

3. Warning threshold: Free space threshold in kilobytes for warning alert. No 
default is provided.

Output
Disk name and space available in kilobytes on the disk.

Disk Full (%)
This event test monitors the same file systems as the Disk Full event test. The Disk 
Full (%) event test, however, returns the percentage of space remaining on the disk 
destinations.

Parameters
1. Disk name: Name of the disk to be monitored. No default is provided.

2. Critical threshold: Percentage of free space threshold for critical alert. Default is 
30%.

3. Warning threshold: Percentage of free space threshold for warning alert. 
Default is 50%.

Output
Disk name and percentage of space available on the disk.

Note: "*" is not a supported disk name.

Note: "*" is not a supported disk name.
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Swap Full
This event test checks for available swap space. If the space available falls below the 
values specified in the threshold arguments, then a warning alert or critical alert is 
generated. 

Parameters
1. Critical threshold: Free space threshold in percentage for critical alert. No 

default is provided.

2. Warning threshold: Free space threshold in percentage for warning alert. No 
default is provided.

Output
Current used space in percentage.

CPU Utilization
This event test checks for the CPU utilization (percentage used) against the 
threshold values specified by the threshold arguments. If the number of occurrences 
exceeds the values specified, then a warning alert or critical alert is generated. 

Parameters
1. Number of occurrences: Number of consecutive occurrences before a warning 

or alert is generated.

2. Critical threshold: Threshold for critical alert (%). No default is provided.

3. Warning threshold: Threshold for warning alert (%). No default is provided.

Output 
Current utilization in percentage.

CPU Paging Rate
This event test checks the paging rate (kilobytes/second paged in/out) against the 
threshold values specified by the threshold arguments. If the number of occurrences 
exceeds the values specified, then a warning alert or critical alert is generated. 

Parameters
1. Number of occurrences: Number of consecutive occurrences before a warning 

or alert is generated.
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2. Critical threshold: Alert threshold for critical alert (kilobytes/second). No 
default is provided.

3. Warning threshold: Warning threshold for warning alert (kilobytes/second). No 
default is provided.

Output
Current rate in kilobytes/second.
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